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Samenvatting
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Voorwoord
GRAMPS is een software pakket voor genealogisch onderzoek. Alhoewel het gelijkt op andere genealogische
programma's, biedt GRAMPS toch een aantal unieke en krachtige kenmerken, die we verder zullen bespreken.

GRAMPS is een Open Bron pakket, wat wil zeggen dat u vrij bent om kopieën te maken en te verdelen aan wie u
wil. Het programma werd ontwikkeld en wordt onderhouden door een wereldwijde groep van vrijwilligers. Hun
doel is om GRAMPS krachtig te maken, maar toch eenvoudig om te gebruiken.

1. Waarom GRAMPS gebruiken?
De meeste genealogische programma's laten u toe om informatie over uw nakomelingen en voorouders in te geven.
Ze tonen meestal de familie relaties in grafische of tekst vorm. En mogelijk hebben ze functies die u toelaten om
gegevens uit te wisselen met andere programma's en om verschillende vormen van rapporten uit te drukken.

GRAMPS biedt al deze mogelijkheden en meer dan dat. Het programma laat u toe om stukjes informatie die door
onderzoek werden verzameld te integreren in een plaats : uw computer. U kunt dan uw computer gebruiken om
deze gegevens te analyseren, te manipuleren en te correleren zonder hopen papier te gebruiken.

2. Typografische afspraken
In dit boek werden sommige woorden gemarkeerd met een speciale typografie:

• Toepassingen

• Opdrachten die u typt op de opdrachtregel

• Bestandsnamen

• Vervangbare tekst

• Labels voor knoppen en andere onderdelen van de grafische interface

• Menu keuzes zien er zou uit: Menu->Submenu->Menu Item

• Knoppen die u kan aanklikken

• Alles wat u intypt

The manual also provides assorted bits of additional information in tips and notes, as follows.

Voorbeeld tip

Tips en bijkomende informatie wordt als volgt getoond.

Voorbeeld opmerking

Opmerkingen zien er zo uit.

Dit zijn tot slot, waarschuwingen die u verwittigen dat u voorzichtig moet zijn:

Voorbeeld waarschuwing

Zo ziet een waarschuwing er uit. Wanneer er problemen te verwachten zijn, wordt u op voorhand
verwittigd.
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Hoofdstuk 1. Beginnen
In dit hoofdstuk starten we met de basis. We tonen u hoe u GRAMPS start en hoe hulp te krijgen wanneer u het
nodig hebt.

1.1. GRAMPS starten
U kunt GRAMPS op een aantal manieren starten:

Via het Toepassingen menu Selecteer GRAMPS in de getoonde lijst van programma's in het menu Toepas-
singen van uw computer. (De plaats en het voorkomen van deze lijst hangt af van
uw Linux distributie. Op het standaard GNOME bureaublad, vindt u GRAMPS
onder het menu Toepassingen->Andere.

Via een opdrachtregel Indien u vertrouwt bent met Linux en u graag via de opdrachtregel werkt, kunt
u GRAMPS starten door via een terminal venster, en geef de opdracht gramps
en druk dan Enter te drukken.

Als u wilt dat bij het opstarten van GRAMPS een bepaald gegevensbestand ge-
opend wordt, of een bepaald bestand geïmporteerd wordt, kunt u de bestands-
naam meegeven als een bijkomend gegeven in de opdrachtregel

gramps bestandsnaam.grdb

bestandsnaam.grdb is de naam van het bestand dat u wilt openen. De op-
drachtregel geeft nog veel meer mogelijkheden om GRAMPS te starten en ver-
scheidene taken uit te voeren.

1.2. Kies een gegevensbestand
Wanneer GRAMPS opstart zonder dat een gegevensbestand gekozen wordt, zal het opstartscherm weinig functi-
onaliteit bieden.De meeste bewerkingen zijn niet beschikbaar. Om een gegevensbestand te laden, kiest u Nieuw
om een nieuw gegevensbestand aan te maken, of Openen om een bestaand gegevensbestand te openen. GRAMPS
houdt bij welke gegevensbestanden laatst geopend werden. Deze kunnen geselecteerd worden door op de pijl naast
de Openen knop te klikken en dan een bestand te kiezen van het menu.

Figuur 1.1. Startvenster
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1.3. Hulp verkrijgen
GRAMPS bevat een Hulp menu dat u steeds kunt raadplegen. Het bevat volgende items:

Gebruikershandleiding Een elektronische versie van de handleiding die u kunt raadplegen terwijl
u in GRAMPS werkt.

FAQ : veelgestelde vragen(-lijst) Veelgestelde vragen(-lijst) over GRAMPS.

Dagtip geef de "Tip van de dag" dialog weer.

Status van de Plugin : additionele
uitbreidingen

Gebruik deze item om de status van alle, door u toegevoegde, uitbreidingen
weer te geven

GRAMPS thuispagina This item opens your web browser and connects to the GRAMPS' project
web site.

GRAMPS mailing-lijsten This item opens your web browser to the GRAMPS mailing list page. At
this page, you can browse the mailing list archives or join the mailing list

Rapporteer een fout Kies dit item om een foutrapport door te geven naar het foutopvolgingssys-
teem. (Denk eraan, GRAMPS is een levend project. We willen graag alle
problemen die u tegenkomt, weten, zodat we oplossingen kunnen zoeken
zodat GRAMPS steeds beter wordt.

Over Deze item geeft een dialoog weer die algemene informatie toont welke
GRAMPS-versie u momenteel draait.
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Hoofdstuk 2. Hoofdvenster
Wanneer u een gegevensbestand (een bestaand of nieuw), zal het volgende venster getoond worden:

Figuur 2.1. GRAMPS Hoofvenster

Het GRAMPS hoofdvenster bevat de volgende elementen:

Menubalk De Menubalk bevindt zich helemaal bovenaan het venster(juist onder de venstertitel)
en verschaft toegang tot alle mogelijkeheden van GRAMPS.

Hulpmiddelenbalk De hulpmiddelenbalk bevindt zich juist onder de menubalk. Dit geeft toegang tot de
meest gebruikte functies in GRAMPS. U kunt zelf bepalen hoe de hulpmiddelenbalk er
dient uit te zien, door Bewerken->Voorkeuren aan te klikken. U kunt ook de volledige
balk onzichtbaar maken door Beeld->Hulpmiddelenbalk aan te klikken.

Voortgangsbalk The Progress Bar is located in the lower left corner of the GRAMPS window. It displays
the progress of time consuming operations, such as opening and saving large databases,
importing and exporting to other formats, generating web sites, etc. When you are not
doing these types of operations, the Progress Bar is not shown.

Statusbalk The Status Bar is located to the right of the Progress Bar, on the very bottom of the
GRAMPS window. It displays information about current GRAMPS activity and con-
textual information about the selected items.

Weergavegebied Het grootste gebied in het midden van het GRAMPS venster is het weergavegebied.
Wat hier getoond wordt hangt af van het huidige gekozen scherm. We zullen dit in
detail verder bespreken.

2.1. Schermen
Genealogical information is very broad and can be extremely detailed. Displaying it poses a challenge that
GRAMPS takes on by dividing and organizing the information into a series of Views. Each View displays a por-
tion of the total information, selected according to a particular category. This will become clearer as we explore
the different Views, listed below:

Personenscherm Displays the list of people in the database
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Relatiescherm Shows the relationships between the Active Person and other people. This inclu-
des parents, spouses, and children

Scherm Familie Lijst Shows the list of families in the database

Afstammelingenscherm Toont een grafische stamboom voor de geselecteerde persoon

Gebeurtenissenscherm Displays the list of events in the database

Bronnenscherm Displays the list of sources in the database

Locatiescherm Displays the list of places in the database

Mediascherm Displays the list of media objects in the database

Bibliothekenscherm. Displays the list of repositories in the database.

Voor we de beschrijving van de verschillende schermen uitleggen, laat ons eerst uitleggen hoe u wisselt tussen
de verschillende schermen.

2.1.1. Schermen wisselen en weergavemodus

As mentioned above there are nine different Views. In addition, there are two different Viewing Modes. You can
tell at a glance which Viewing Mode you are in: If you see icons listed vertically in a sidebar at the left of the
window, you are in the Sidebar Viewing Mode. If instead you see a series of "notebook tabs" (labeled People,
Relationships, Family List, Pedigree, Events, Sources, Places, Media and Repositories) that run horizontally across
the window, then you are in the Tabbed Viewing Mode. You can switch from one Viewing Mode to another by
selecting View->Sidebar from the Sidebar menu item.

If you're in the Sidebar Viewing Mode, you can select the View you want by clicking one of the sidebar icons.

Figuur 2.2. Weergave zijbalk

Indien u zich bevindt in de modus met tabbladen, kunt u door te klikken op de overeenkomende tab, het gepaste
scherm kiezen.
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Figuur 2.3. Modus met tabbladen

2.1.2. Personenscherm

The People View lists the people stored in the database. You'll note that people are grouped according to their
family names. To the left of each family name is typically either an arrow or some other type of indicator. Clicking
it once will reveal the entire list of people sharing that name. Clicking the indicator again will "roll up" the list
and show only the family name.

By default, the People View, displays the several columns of information about each person. You can add or
remove columns to and from the display by calling up the Column Editor dialog ( Edit->Column Editor) and
checking or unchecking the boxes listed. You can also change the position of a column in People View by clicking
and dragging it to a new position in the Editor. Once you have made the changes you want, click OK to exit the
Editor and see your changes in the People View.

Aanpassen van kolommen

Aanpassen van de kolommen kan in alle schermen en werkt overal op dezelfde manier.
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Figuur 2.4. Dialoog aanpassen kolommen

2.1.2.1. Filters

Genealogical databases can contain information on many people, families, places, and objects. It's therefore pos-
sible for a View to contain a long list of data that's difficult to work with. GRAMPS gives you two different means
for controlling this condition by allowing you to filter a list to a more manageable size. These methods are Search
and Filtering. A search will search the text displayed in list, whereas filters display people whose data match the
criteria of the filter.

Zoeken is een eenvoudige maar snelle methode om kolommen die getoond worden op het scherm, te onderzoeken.
Indien u de letters in het zoekveld ingeeft en op de zoekknop drukt, zullen enkel die lijnen getoond worden die
overeenkomen met de ingegeven tekst.

U kunt ook de filterzijbalk inschakelen, die dan aan de rechterzijde van het scherm getoond wordt. Wanneer de
filterzijbalk getoond wordt, is de zoekbalk niet zichtbaar. Het filter zal werken op de gegevens, niet op het getoonde
scherm.

Searching vs. Filtering

Searching only searches for exact text matches. If the date displayed is "Jan 1, 2000", a search of
"1/1/2000" will fail, but a filter of "1/1/2000" will match.
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Figuur 2.5. Controle van de filters wordt getoond

Wanneer GRAMPS een gegevensbestand opent, zijn geen filters actief. In het Scherm Personen bijv. worden
standaard alle personen in het gegevensbestand getoond.

2.1.3. Relatiescherm
The Relationships View displays all the relationships of the Active Person (the selected person). Specifically, it
shows his or her parents, siblings, spouses, and children.

The Relationships View is designed to allow for quick navigation. You can quickly change the Active Person
simply by clicking the name of any person listed on the page. Each name is actually a hypertext link, similar to
a web page.

Figuur 2.6. Relatiescherm

Het relatiescherm toont de volgende secties:

Active Person At the top of the screen, name, ID, birth, and death information of the Active Person is
displayed. If a photo of the person is available, it is shown on the right hand side. Next to the
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person's name is a symbol indicating gender, and an Edit button. Clicking the Edit button
will allow you to edit all of the person's individual information in an Edit Person dialog.

Ouders The next section, the Parents section, displays the families in which the person is a child.
Since it is possible for a person to have multiple sets of parents, it is possible to have several
Parents sections.

You can control how much information is displayed by using the View menu. The view
menu allows you to show or hide details (the birth and death information) and to show or
hide siblings. Next to each person listed is an Edit button, which will allow you to edit all
the details of that particular person.

You may add a new set of parents by either selecting the Add Parents or the Share Parents.
The Add Parents button will create a new family with the Active Person listed as a child.
The Share Parents button will allow you to choose from a list of existing families, and then
add the person as a child to that family.

You may edit an existing parents by selecting the Edit button next to the parents. If you
select the Delete next to a set of parents, then the Active Person will be removed as a child
from the parents. This button does not delete the parents' relationship.

Waarschuwing

Het is mogelijk om meerdere families aan te maken met de zelfde ouders in-
dien u niet voorzichtig bent. Dit is niet de normale situatie die de gebruiker
wenst. GRAMPS zal dan ook een waarschuwingsdialoog tonen indien u tracht
een nieuwe familie aan te maken met dezelfde ouders als een reeds bestaande
familie. Wanneer deze dialoog getoond wordt, is het waarschijnlijk beter aan-
passingen te verwerpen en door gebruik te maken van de Selecteren knop een
bestaande familie te kiezen.

Familie Similar to the Parents section is the Family section, which displays families where the Active
Person is a parent. Because it is possible to have multiple familes, it is possible to have
multiple Family sections. Each family section displays the spouse and any children.

Opmerking

We gebruiken eenvoudigheidshalve de benaming echtgeno(o)t(e). Denk eraan
dat echtgeno(o)t(e) ook een huispartner kan zijn of een partner in een wette-
lijke verbinding of vele andere gelijkwaardige relaties tussen twee mensen.
Echtgeno(o)t(e) relaties zijn zelfs niet beperkt tot relaties tussen een man en
een vrouw.

You may add a family by selecting the Add Spouse in the toolbar. This will create a new
family with the Active Person listed as a father or mother.

Selecting the Edit button next to the spouse will allow you to edit the displayed family.
Clicking the Delete button will remove the person from the displayed family.

Waarschuwing

Een persoon verwijderen uit een familie, verwijderd niet de familie zelf. De
persoon wordt enkel als vader of moeder verwijderd; alle andere familierela-
ties blijven bestaan.

Opmerking

We gebruiken eenvoudigheidshalve de benamingen vader en moeder.Zelfs in-
dien er geen kinderen in een familie zijn, wordt deze vader en moeder termi-
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nologie gebruikt. In het geval van een man/man of vrouw/vrouw relatie, wor-
den deze vader en moeder benamingen ook uit gewoonte over genomen.

You can reorder the parents and spouses by selecting the Reorder. This option will only be
enabled if more than one set of parents or more than one set of spouses exists for the Active
Person. Selecting this button will display a dialog that will allow you to reorder the families.

Figuur 2.7. Relationship Reordering Window

2.1.4. Scherm Familie Lijst
Het Scherm Familie Lijst toont een lijst van alle families in het gegevensbestand. Vanuit dit Scherm, kunt u families
toevoegen, verwijderen en aanpassen. Het standaard scherm geeft ID, Vader, Moeder en Relatievorm. Kinderen
kunnen op dit scherm niet getoond worden.

Figuur 2.8. Scherm Familie Lijst

Waarschuwing

In tegenstelling tot het Relatiescherm zal door aanklikken van de Verwijder knop, de familie wel
degelijk verwijderd worden uit het gegevensbestand. Alle personen blijven behouden, maar alle re-
laties tussen personen in de familie worden verwijderd.

2.1.5. Afstammelingenscherm
The Pedigree View displays a family tree of the Active Person's ancestors. The Pedigree View shows up to five
generations, depending on the size of the window. Each person is indicated by a box labeled with his or her name,
birth and death information, and optionally an image if available. Two lines branch from each box. The top one
shows the person's father and the bottom one the mother. Solid lines represent birth relations, while dashed lines
represent non-birth relations such as adoption, step-parenthood, guardianship, etc.
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Figuur 2.9. Afstammelingenscherm

To the left of the Active Person is a left arrow button. If the Active Person has children, clicking this button expands
a list of the Active Person's children. Selecting one of the children makes that child the Active Person.

The appearance of the children's names in the menu differentiates the dead ends of the tree from the continuing
branches. Children who have children themselves appear in the menu in the boldface and italic type, while children
without children (dead ends) appear in a regular font. If the Active Person has only one child, no menu will be
displayed (since there is only one choice) and the child will become the Active Person when the arrow button
is clicked.
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Figuur 2.10. Menu kinderen
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The right-hand side of the window shows two right arrow buttons. When the top button is clicked, the Father of
the Active Person becomes the Active Person. When the bottom button is clicked, the Mother of the Active Person
becomes the Active Person.

Figuur 2.11. Personal Context Menu

Right-clicking on any person's box in the Pedigree View will bring up the "context menu". Among other useful
items, the context menu has sub-menus listing Spouses, Siblings, Children, and Parents of that person. "Greyed-
out" sub-menus indicate the absence of the data in the appropriate category. Similar to the children menu above,
Childrens' and Parents' menus distinguish continuing lines from dead ends.

2.1.6. Gebeurtenissenscherm

New in version 2.2 is the inclusion of an Events View. Events can be shared between multiple people and multiple
families. The Events View lists the all the events recorded in the database. The default view displays the Descrip-
tion, ID, Type, Date, Place and Cause of the event.

Figuur 2.12. Gebeurtenissenscherm

Waarschuwing

Omdat gebeurtenissen gedeeld kunnen worden, kunt u best de tijd nemen om elke gebeurtenis te
voorzien van een unieke en betekenisvolle beschrijving. Dit zal u toelaten om de juiste gebeurtenis
terug te vinden als u besluit om gebeurtenissen te delen.

The list of Events can be sorted in the usual manner, by clicking on the column heading. Clicking once sorts in
ascending order, clicking again sorts in descending order. The Column Editor dialog can be used to add, remove
and rearrange the displayed columns.
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2.1.7. Bronnenscherm

Sources View lists the sources of certain information stored in the database. These can include various documents
(birth, death, and marriage certificates, etc.), books, films, journals, private diaries, - nearly anything that can
provide genealogical evidence. GRAMPS gives you the option to provide a source for each event you record
(births, deaths, marriages, etc.). The Sources View lists the Title, ID, and Author of the source, as well as any
Publication information that may be associated with it.

The list of Sources can be sorted by clicking on a column heading. Clicking once sorts in ascending order, clicking
again sorts in descending order. The Column Editor dialog can be used to add, remove and rearrange the displayed
columns.

Figuur 2.13. Bronnenscherm

2.1.8. Locatiescherm

The Places View lists the geographical places in which the events of the database took place. These could be places
of birth, death, and marriages of people, as well as their home, employment, education addresses, or any other
conceivable reference to the geographical location. The Places View lists the places' Name, ID, Church Parish,
City, County, State, and Country. All of these columns can be used for sorting by clicking on a column heading.
Clicking once sorts in ascending order, clicking again sorts in descending order. The Column Editor dialog may
be used to add, remove and rearrange the displayed columns.

If a place has been highlighted, you may select the Google Maps button to attempt to display the place in a web
browser. Your default web browser should open, attempting to use either the longitude and lattitude coordinates
or the place name to display the location using the Google Maps web site. This feature is limited, and may not
always produce the results you desire.
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Figuur 2.14. Locatiescherm

2.1.9. Mediascherm

Het Media Scherm is een lijst van de Media Objecten gebruikt in het gegevensbestand. Alle bestanden die enigzins
in verband kunnen gebracht worden met genealogische gegevens komen hiervoor in aanmerking. Technisch gezien
kan gelijkwelk bestand opgeslagen worden als een Media Object. Meestal zijn het beelden, geluidsbestanden,
animatiebestanden, enz. De lijst getoond in een venster onderaan geeft een overzicht van Naam, ID, Type, en Pad
van de Media Objecten. De Dialoog Aanpassen Kolommen kan gebruikt worden om de getoonde kolommen ter
verplaatsen volgens de normale sorteerregels. Het bovenste deel van het venster toont een beeld (indien voorradig)
en informatie van het Media Object.

Figuur 2.15. Mediascherm
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2.1.10. Bibliothekenscherm.
Versie 2.2 geeft ondersteuning van Bibliotheken. Een bibliotheek kan beschouwd worden als een verzameling van
bronnen. Elke bron kan verwijzen naar een bibliotheek (zoals een boekerij) waar de bon in vervat is. De werking
van het Scherm Bibliotheken is gelijkaardig aan de andere Schermen.

Figuur 2.16. Bibliothekenscherm.
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Hoofdstuk 3. Gebruik
Nu gaan we naar een meer uitgebreide exploratie van het dagelijks GRAMPS gebruik. Allereerst wijzen we erop
dat GRAMPS vaak verschillende mogelijkheden biedt om eenzelfde taak te doen. Waar van toepassing, zullen
we de verschillende alternatieven toelichten.

3.1. Een nieuw gegevensbestand starten
Om een nieuw gegevensbestand te starten, kies Bestand->Nieuw of selecteer de Nieuw knop van de gereedschaps-
balk. U wordt dan gevraagd om een naam op te geven voor het nieuwe gegevensbestand.

GRAMPS-gegevensbestanden

GRAMPS slaat uw gegevens op in een gegevensbestand van het Berkeley type, soms aangeduid als
BSDDB. Deze bestanden hebben ".grdb" als standaard extensie. Deze extensie wordt automatisch
toegevoegd aan uw bestandsnaam.

3.2. Een gegevensbestand openen
De dialoog Gegevensbestand openenen wordt getoond en u krijgt een lijst van bestanden te zien. Indien u de
bestanden waarnaar u zoekt niet vindt, kijk dan dat de 'Alle bestanden' filter geselecteerd is. (Deze dialoog heeft een
"bestandstype" filter, wat tot gevolg kan hebben dat enkel bestanden met een bepaalde extensie getoond worden.)

Om een recent geopend bestand te heropenen, kan u ofwel Bestand->Recent geopend kiezen of de pijl naar bene-
den, gebruiken naast de knop Openen en dan selecteren.

Indien u geen "schrijfrechten" hebt voor het geselecteerd bestand, wordt dit bestand geopend in de modus 'Enkel
Lezen'. In deze modus kunnen gegevens bekeken worden, maar zullen er geen veranderingen aan het bestand
mogelijk zijn. Ter indicatie zal aan de titel van het hoofdscherm de tekst (Enkel Lezen) toegevoegd worden.

GRAMPS voorziet in de mogelijkheid om bepaalde gegevensbestanden die niet in het eigen GRAMPS formaat
zijn opgeslagen, te openen. Dit geldt voor GEDCOM en XML gegevensbestanden. Hou er echter rekening mee
dat indien deze bestanden relatief groot zijn, u uitvoeringsproblemen kan tegenkomen. Deze kunnen echter voor-
komen worden door een nieuw GRAMPS gegevensbestand aan te maken en de XML/GEDCOM gegevens hierin
te importeren.

Openen van XML en GEDCOM-gegevensbestanden

XML en GEDCOM-gegevensbestanden vereisen dat alle gegevens in het geheugen geladen worden.
Voor GRAMPS eigen grdb formaat is dit niet noodzakelijk. Daarom kan een grdb gegevensbestand
sneller en efficiënter gegevens beschikbaar stellen.

Aanpassen GEDCOM

Denk eraan dat sommige informatie in een GEDCOM-bestand verloren kan gaan bij het importeren in
GRAMPS. Het bestand wordt niet veranderd wanneer u enkel het bestand opent en bekijkt. Wanneer
u echter aanpassingen maakte en deze niet verworpen hebt bij het sluiten van het bestand, zal bij
het afsluiten van GRAMPS, de gegevens worden opgeslagen met mogelijk verlies van informatie
tot gevolg.

3.3. Opslaan van veranderingen aan uw gege-
vensbestand
Zodra u gegevens aanpast, worden veranderingen opgeslagen. Dus telkens wanneer u op de OK knop klikt, worden
uw gegevens opgeslagen. Er is geen aparte "opslaan" opdracht (er is echter wel een "opslaan als" opdracht, maar
die zal later besproken worden.)
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You can undo changes you've made by selecting Edit->Undo. If you select this command repeatedly, your most
recent changes will be undone one at a time. To roll back multple commands at a time, you can using the Undo
History dialog available from the Edit menu.

Wanneer u terug wilt keren naar de oorspronkelijk toestand voor veranderingen van het gegevensbestand, gebruikt
u Bestand->Veranderingen verwerpen en verlaten. (Dit is eigenlijk zoals programma verlaten zonder op te slaan
zoals in vele andere programma's.)

If you would like to save your database under a different name, you can do so by choosing File->Save as... and
specifying the name (and, optionally, the format) of your new database. Note that Save as will allow you to
continue editing the newly saved database. If this is not what you want to do, you may wish to use the Export
command instead.

3.4. Importeren van gegevens
Importeren laat u toe om gegevens van andere genealogische programma's in een GRAMPS gegevensbestand te
laden. Momenteel kunnen in GRAMPS volgende formaten geladen worden:

• Another GRAMPS database (having the grdb file extension),

• GEDCOM

• GRAMPS XML

• GRAMPS-pakket

• GeneWeb

Importeren t.o.v. openen

Importeren van een gegevensbestand is iets totaal anders dan een gegevensbestand openen. Bij im-
porteren worden daadwerkelijk informatie van één gegevensbestand naar een GRAMPS-gegevens-
bestand overgebracht. Bij het openen van een bestand, worden aanpassingen rechtstreeks op dit be-
stand uitgevoerd.

Om gegevens te importeren kiest u Bestand->Importen. De dialoog Importeer gegevensbestand zal verschijnen
en zal u vragen een naam van een bestand op te geven.

Gegevensverlies bij sommige formaten

Belangrijk! Het importeerproces vanuit GEDCOM en GenWeb gegevensbestanden is niet perfect.
Er bestaat een kans dat sommige informatie niet volledig wordt overgezet naar GRAMPS.

Het GRAMPS gegevensbestand (grdb), GRAMPS XML en GRAMPS pakketbestand zijn alle eigen GRAMPS
formaten. Er is geen kans op gegevensverlies wanneer geïmporteerd of geëxporteerd wordt naar deze formaten.

GRAMPS-gegevensbestand (grdb) Het basisformaat van het GRAMPS-gegevensbestand is een specifieke
vorm van een Berkeley Database (BSDDB met een speciale structuur van
de gegevenstabellen. Dit formaat is binair en is architectuurafhankelijk. Het
is zeer snel en efficiënt, maar niet algemeen verplaatsbaar naar andere com-
puters met een andere binaire architectuur (bijv. i386 t.o.v. alpha).

GRAMPS XML Het GRAMPS XML bestand was de standaard voor de oudere versies van
GRAMPS. Dit formaat is architectuur-onafhankelijk en kan door mensen
gelezen worden, dit in tegenstelling tot het grdb-formaat. Het gegevensbe-
stand kan ook verwijzingen bevatten naar niet-locale (externe) media voor-
werpen, en daarom is het niet zeker dat het bestand volledig overzetbaar is.
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GRAMPS-pakket Het GRAMPS-pakket is een gecomprimeerd archief dat het GRAMPS
XML bestand bevat samen met alle media objecten (beelden, geluidsbe-
standen, enz.) waarnaar het gegevensbestand verwijst. Omdat het dus ook
alle media objecten bevat, is het volledig overzetbaar. Het pakket wordt
aangemaakt door exporteren van gegevens onder dit formaat ( Bestand-
>Exporten... ).

Indien u gegevens importeert van een ander GRAMPS-bestand of een GRAMPS XML bestand kunt u de voortgang
controleren in de voortgangsbalk in het GRAMPS-hoofdvenster.

3.5. Gegevens exporteren
Exporteren laat u toe om gelijk welk deel van uw GRAMPS-gegevensbestand te delen met andere onderzoekers of
om uw gegevens beschikbaar te maken op een andere computer. Momenteel kunt u vanuit GRAMPS gegevens ex-
porteren naar de volgende formaten: GRAMPS-gegevensbestand (grdb), GRAMPS XML, GEDCOM, GRAMPS
pakket, Web Family Tree (WFT) en GeneWeb.

Exporteren betekent een kopie bewaren

Wanneer u exporteert, slaat u een kopie op van het gegevensbestand dat momenteel geopend is.
Exporteren maakt een ander bestand aan dat een kopie is van het andere bestand. Let op : het gege-
vensbestand dat open blijft staan is NIET het geëxporteerde bestand. Bijkomende aanpassingen van
het bestand dat geopend is zal de geëxporteerde kopie niet wijzigen.

Om gegevens te exporteren, kiest u Bestand->Exporten. Dit zal de Exportassistent tonen.De volgende schermen
zullen u door de formaatselectie (zie Figuur 3.1, “Export assistent: keuze van het formaat”), bestandsselectie en
specifieke exportopties (zie Figuur 3.2, “Exporteer hulp: GEDCOM opties”) loodsen.

Figuur 3.1. Export assistent: keuze van het formaat

3.5.1. Exporteren naar het GEDCOM-formaat

GRAMPS laat u toe om het gegevensbestand te exporteren naar een gewoon GEDCOM-formaat. Het geeft u opties
om uw export te optimaliseren. (zie Figuur 3.2, “Exporteer hulp: GEDCOM opties”.
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Coderen Omdat verschillende talen verschillende karakters gebruiken, is het belang-
rijk om aan een GEDCOM-bestand mee te geven welke karakterset wordt
gebruikt. De twee formaten die normaal geaccepteerd worden zijn ASCII
en ANSEL. Omdat alle ASCII karakters geldige ANSEL karakters zijn,
heeft GRAMPS geen optie voor het kiezen van ASCII.

Because ANSEL is not commonly used, some genealogy programs will
accept ANSI (more commonly know as ISO-8859-1) and Unicode character
sets. Only select ANSI or Unicode if you know any program that attempts
to read the GEDCOM file will understand these character sets.

Filter The filter allows you to export a limited amount of data, based on the criteria
you select.

Doel While GEDCOM is a standard, not every program implements it in the same
way. This can lead to data loss. GRAMPS can reduce the data loss in some
cases. You can tell GRAMPS what program is the target, and GRAMPS
will customize the exported file for that program. If your program is not
listed, choose the "GEDCOM 5.5 Standard".

Copyright Allows you to select a statement to describe your Copyright claim.

Do not include records marked pri-
vate

Klik deze vierkantje aan om te voorkomen dat private gegevens in het ge-
ëxporteerde bestand worden meegenomen.

Beperk gegevens over nog in leven
zijnde personen

Check this box to limit the information exported for living people. This
means that all information concerning their birth, death, addresses, signi-
ficant events, etc., will be omitted in the exported GEDCOM file. If you
choose this option, you will be given additional options to limit further the
data on living people. For example, you can choose to substitute the word
"Living" for the first name; you can exclude notes; and you can exclude
sources for living people.

Sometimes, it is not always obvious from the data if someone is actually
alive. GRAMPS uses an advanced algorithm to try to determine if a person
could still be alive. Remember, GRAMPS is making its best guess, and it
may not always be able to guess correctly all the time. Please double check
your data.

Reference images from path Check this box to tell GRAMPS to use the specific path for your images
when writing image references in GEDCOM.

This option allows specify where your image files are located. This is useful
when you are transfering your GEDCOM file from one computer to ano-
ther. It tells the program that is importing the data where your images are.
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Figuur 3.2. Exporteer hulp: GEDCOM opties

3.5.2. Export into GRAMPS formats
GRAMPS database (grdb) export Exporting to the GRAMPS native format will simply make a copy of your

data under another name. Exporting to this format can also be useful if you
have directly opened an XML or GEDCOM file and would like to save it
as the grdb file.

Exporteren van GRAMPS XML
gegevensbestand

Exporting into GRAMPS XML format will produce a database compatible
with the previous versions of GRAMPS. As XML is a text-based human-
readable format, you may also use it to take a look at your data.

GRAMPS-pakket export Exporting to the GRAMPS package format will create a compressed file
that contains the database and copies of all associated media files. This is
useful if you want to move your database to another computer or to share
it with someone.

Exporteren naar CD Exporting to CD will prepare your database and copies of all media object
files for recording onto a CD. To actually burn the CD, you will need to go to
the GNOME burn:/// location, which can be accessed by navigating through
Nautilus: After exporting to CD, select Go->CD Creator in the Nautilus
menu. Your database directory will show up. To burn it to the CD, click the
CD icon on the Nautilus toolbar, or select File->Write to CD in the Nautilus
menu.

Indien een media bestand niet gevonden wordt tijdens het exporteren, zal u dezelfde Ontbrekende Media dialoog
te zien krijgen die ook voor GEDCOM exporteren gebruikt wordt.

3.5.3. Exporteren naar andere formaten
Web Family Tree Exporteren naar WFT ( Web Family Tree ) zal een tekstbestand aanmaken dat kan

gebruikt worden door het WFT programma. De exporteer opties bevatten filter se-
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lecties en de mogelijkheid om de hoeveelheid gegevens te beperken tot de familie-
banden, voor nog levende mensen.

GeneWeb Exporting to GeneWeb will save a copy of your data into a popular web genealogy
format. To find out more about GeneWeb and its format, visit http://cristal.inria.fr/
~ddr/GeneWeb/en/.

vCalendar en vCard Exporteren naar vCalendar of vCard zal de gegevens in een formaat bewaren dat
door vele kalender- en adresboek programma's wordt gebruikt. Dit wordt soms PIM
(Personal Information Manager) genoemd.

3.6. Ingave en aanpassen van gegevens: snel-
start overzicht
Dit deel wil u de basiskennis geven die nodig is om uw genealogische informatie in GRAMPS te beginnen in te
geven. Het zal uitleggen hoe u personen in het gegevensbestand moet laden en hoe hun familierelaties kunnen
gespecificeerd worden. (Een meer uitgebreide uitleg zal volgen in het deel Paragraaf 3.7, “Invoeren en aanpassen
van gegevens: een volledige beschrijving”.)

Laat ons eerst bekijken welke informatie u kan ingeven in uw GRAMPS gegevensbestand. Deze informatie omvat:

• Persoonlijke informatie van een persoon (namen, adressen, geboorte en overlijdensdata, enz.)

• Informatie over de relaties van een persoon (huwelijken, scheidingen, wettelijke verbintenissen, enz. )

• Informatie over de kinderen en de ouders van een persoon

• Bronnen die uw onderzoek documenteren

Sneltoetsen

Om met GRAMPS te werken kan u menu items en knoppen gebruiken, maar ook kunt u gebruik
maken van een uitgebreide set van "sneltoetsen." Voor meer informatie zie Bijlage B, Sneltoetsre-
ferentie.

Laat ons nu eens kijken hoe u deze verschillende types van gegevens kan invoeren en aanpassen.

3.6.1. Een persoon toevoegen of aanpassen

Er zijn meerdere manieren om een persoon toe te voegen aan het gegevensbestand. We zullen er enkele bespreken
als we verder gaan. De eenvoudigste manier om een persoon toe te voegen is vanuit het Scherm Personen. Wanneer
u in het Scherm Personen bent Figuur 2.2, “Weergave zijbalk”), klik dan Toevoegen op de gereedschapsbalk.
Voer dan alle gegevens die u kent over deze persoon in de Person aanpassen dialoog (zie Figuur 3.8, “Dialoog
aanpassen persoon” voor details).

To edit information about a person already present in the database, select the person from the People View and
click the Edit button on the toolbar.

Alternate ways of adding or editing a person from the People View

You can also use Add... and Edit... menu items available under Edit. Or you can right-click on the
person and select Add... or Edit... from the context menu that pops up.

People can also be added to the database in the Relationships View, Edit Family dialog, and other places where
it makes sense.

http://cristal.inria.fr/~ddr/GeneWeb/en/
http://cristal.inria.fr/~ddr/GeneWeb/en/
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3.6.2. Een relatie specificeren

There are two primary ways to specify relationships between people - using the Relationships View and using the
Edit Family dialog from the Family List View. The Family List is usually used to build all the relationships within
a single family at a time. The Relationships View is usually used to build multiple relationships to a single person.

To specify a new relationship to the Active Person, switch to the Relationships View (Figuur 2.6, “Relatiescherm”)
and you'll see this individual indicated as the "Active Person". Next to the Family label is a Add button (typically
represented by a + sign). Clicking the Add button will display the Edit Family dialog with the Active Person set
as either the father or the mother.

Figuur 3.3. Een familie aanpassen

Now a question: Does the person who will form the relationship with the Active Person already exist in the
database? If yes, click the Select button to the other person. You'll then be able to browse through the list of people
in the database to select the one you want. If not, click the Add button. This will allow you to add a new person
to the database and to specify the relationship this person has to the Active Person.
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Figuur 3.4. Een persoon selecteren

Filteren

By default, GRAMPS filters the displayed list to show only those people who could theoretically
have a relationship with the Active Person. That is, GRAMPS only shows those people whose birth
dates and death dates fit within the lifetime of the Active Person. If you wish, you can add a person
to the list by clicking the + button. To completely override the filter and display all people from the
database, check the Show all box.

To edit an existing relationship from the Relationships View, click on the Edit button next to corresponding Family
entry. If there is more than one relationship in the list, you can select the spouse or partner you want by clicking
the corresponding Edit button next to the relationship.

To specify a new relationship in the Family List View, click on the Add button on the toolbar, and an empty Edit
Family dialog will open. At this point, you can add people to the family.

3.6.3. Ouders specificeren

You can specify Active Person's parents in the Relationship View(Figuur 2.6, “Relatiescherm”). A little care is
required to prevent the creation of duplicate families. If you wish to add the Active Person to an already existing
family, you should click the Select button. If the family including the parents does not already exist, you should
click the Add button.

If you click on the Select button, you are presented with the Select Family dialog. This will allow you to select
the existing family, and then the Active Person will be added as a child to the family.
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Figuur 3.5. Een familie selecteren

If you click on the Add button, a new Edit Family dialog is presented with the Active Person listed a child of
the new family. You can add the parents to the family by either adding new people as the parents or selecting
existing people as the parents.

Waarschuwing

Indien u een nieuwe familie aanmaakt en hiervoor ouders kiest die al in een bestaande familie zijn,
zal GRAMPS een waarschuwingsbericht laten zien. Indien u toch verder gaat en de familie opslaat,
zal een dubbele familie worden aangemaakt.

Figuur 3.6. Waarschuwing dubbele familie

You can also specify the parents of a person in the Family List View. If the family already exists, click on the Edit
button on the tool bar and add the person as a child when the Edit Family dialog is displayed. If the family does
not already exist, click the Add button to create a new family, and add the appropriate parents and children.

3.6.4. Kinderen specificeren
Adding children to a relationship is done through a similar proceedure. From the Relationships View or the Family
List View, select the existing family or create a new family. Children can be added by selecting the Add button
or Select button to the right of the child list.
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Clicking the Add button will display the Edit Person dialog, allowing you to enter a new person. Clicking on the
Select button, will allow you to select an existing person from a list. By default, the child is added with a the
relationship type of birth to both parents.

If you wish to change the parent/child relationship from the default setting of birth, select the child and click on
the Edit button. This will display the Edit Child Reference dialog.

Figuur 3.7. Kind referentie Aanpasser

3.6.5. Foto's en andere media objecten toevoegen

You can add photos and other media objects to individual people, events, sources, and places. You can also add
images that might not be limited to a single person or event (for example, group family photos).

If you want to add an image to a single person, switch to the People View (Figuur 2.2, “Weergave zijbalk”),
select a person, and then click the Edit icon on the toolbar. This will bring up the Edit Person dialog (Figuur 3.8,
“Dialoog aanpassen persoon”). Next, select the Gallery tab, and click the + button to call up the Select a media
object dialog. Type a filename or browse to find the image file you want and then provide a title for that image.
Keep adding images until you are done.

To add images related to a relationship (for example, a marriage), switch to the Family View (Figuur 2.6, “Rela-
tiescherm”) and double-click on the Spouse box. This calls up the Marriage/Relationship editor dialog. Select the
Gallery tab and click the + button to add an image.

To add images related to a source or a place, first switch to the Source View (Figuur 2.13, “Bronnenscherm”) or
Place View (Figuur 2.14, “Locatiescherm”). Select the source or place you want and then either double-click on
it or click the Edit icon on the toolbar. Select the Gallery tab and click the + button to add an image.

Finally, to add images that you want to include in the database, but hare are not limited to any particular person,
relationship, source or place, switch to the Media View (Figuur 2.15, “Mediascherm”). Then click the Add icon
on the toolbar to add an image. If you have already added any images to any individual galleries, you will also
find them listed in the Media View.
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Andere manieren om beelden aan galerijen toe te voegen

An image can always be added to any gallery by using drag-and-drop. Items can be dragged from
the Media View, any gallery, the desktop, the file manager or a web browser and dropped on the
target gallery, adding the image to the gallery.

In gelijk welke galerij kunt u de knop Bewerken gebruiken om beeldinformatie aan te passen en de knop - om de
beeldreferentie uit de galerij te verwijderen.

Een beeld uit de galerij verwijderen

Removing a media object from a gallery does not remove the image from the database. To completely
remove the image from the database, delete it from Media View by first selecting it and then clicking
the Remove icon on the toolbar.

3.6.6. To Edit Events, Sources, Places, and Repositories
To add an event, a source, a place, or a repository to the database, switch to the appropriate Events View (Fi-
guur 2.12, “Gebeurtenissenscherm”), Sources View (Figuur 2.13, “Bronnenscherm”), Places View (Figuur 2.14,
“Locatiescherm”), or Repositories View (Figuur 2.16, “Bibliothekenscherm.”). Then click the Add icon on the
toolbar to add the corresponding object. Enter the information into the Event Editor (Source Editor, Place Editor,
or Repository Editor) dialog.

To edit information about events, sources, places, and repositories already present in the database, switch to the
appropriate view, select an entry you would like to view/modify, and then click the Edit icon on the toolbar.
Alternatively, you may double-click on the entry to edit it.

3.7. Invoeren en aanpassen van gegevens: een
volledige beschrijving
Het vorige deel gaf u een snel overzicht van hoe gegevens in te voeren en aan te passen. Dit deel gaat in meer
detail verder.

Zoals we gezien hebben, heeft GRAMPS verschillende schermen. Elk van deze schermen geeft u mogelijkheden
om gegevens in te voeren en aan te passen. Het is zelfs zo dat u dezelfde informatie kunt zien in verschillende
schermen.

Informatie wordt ingevoerd en aangepast via zogenaamde dialogen. Omdat we deze dialogen vaak gebruiken,
zullen we eerste definiëren wat we er juist mee bedoelen:

A dialog is a pop-up window that provides one or more forms for entering and editing data that fits a certain
category. Examples in GRAMPS include the Edit Person dialog and the Family Editor dialog, among many others.

een dialoog bevat vaak een reeks van "notebook tabs" die de informatie in subcategorieën verdelen. Als voorbeeld
heeft de dialoog "aanpassen persoon" de volgende notebook tabbladen: gebeurtenissen, kenmerken, adressen en
opmerkingen en andere.

De knoppen toevoegen, verwijderen en aanpassen

In most cases, GRAMPS uses a + to correspond to Add, a - correspond to Remove, and an icon of
a pen on a sheet of paper to denote Edit. We will continue referring to the latter as the Edit button,
while using + and - to denote the two former buttons.

3.7.1. Informatie over personen bewerken
Persoonsinformatie wordt ingevoerd en aangepast via Persoon aanpassen dialoog. Deze dialoog verschijnt in de
verschillende schermen op deze manier:
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Via het personenscherm: • Klik tweemaal op de naam van de persoon waarvan u de gegevens wilt
aanpassen

• Selecteer de naam met één enkele klik en klik dan op knop aanpassen.

• Selecteer de naam en druk Enter.

• Selecteer Aanpassen... van het menu Aanpassen

• Selecteer Aanpassen van de contextmenu die verschijnt wanneer u
rechtsklikt op een naam.

Via het relatiescherm: To edit the Active Person's data, click on the Edit button next to the Active
Person's name.

Via het afstammelingenscherm: Klik dubbel op het vak waarin de naam van de persoon staat wiens gegevens
u wilt aanpassen.

In alle bovenvermelde gevallen zal de dialoog Aanpassen persoon getoond worden:

Figuur 3.8. Dialoog aanpassen persoon

The top of the window shows the basic information about the person whose data is being edited. Below are several
"notebook tabs" containing different categories of available information. Click any tab to view and edit its contents.
Clicking the OK button at the bottom will apply all the changes made in all tabs and close the dialog window.
Clicking the Cancel button will close the window without applying any changes. If any data in any tabs were
modified, an alert window will appear, prompting you to choose from the following options: close the dialog
without saving changes, cancel the initial cancel request, or save the changes.

Opmerking

Klik op OK. Alle aanpassingen worden opgeslagen in het gegevensbestand. Alle aanpassingen ge-
beuren automatisch en er is geen aparte 'opslaan' actie.

Tip

Wanneer een opschrift van een tab vet gedrukt is, wil dit zeggen dat er informatie opgeslagen is.
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De algemene informatie wordt bovenaan het venster getoond, zoals primaire naam en algemene informatie.:

Primaire naam includes Given name, Family name, Family prefix (such as "de" or "van"), Suffix (e.g. Jr.
or III), Title (e.g. Dr. or Rev.), Nickname (Bob for Robert), Type of the name (birth name,
married name, etc.). Some of these Family name and Type fields provide "autocompletion"
feature: as you type in these fields, a menu appears below the field containing database
entries that match your partial input. This gives you a shortcut by letting you select an entry
that already exists in the database rather than having to type it all out. You can select the
entry using your mouse or using your arrow and Enter keys.

The Edit (that is, the "pen and paper" icon) next to the Prefix entry field invokes the Na-
me Editor dialog. This dialog allows editing the preferred name in full detail (see Para-
graaf 3.7.9, “Namen”).

Algemeen Het Geslacht menu toont volgende mogelijkheden : mannelijk, vrouwelijk, en onbekend.

Het veld ID toont het GRAMPS ID nummer

The Marker allows you to specify some basic information on the status of your research.

The Privacy button lets you mark whether or not the person's record is considered private.

Beeld The Image area shows the first image available in the Gallery of this person (if any exist).

De tabs geven de volgende persoonlijke informatiecategorieën weer:

Gebeurtenissen De tab Gebeurtenissen geeft u toe alle gebeurtenissen te zien die verbonden zijn met een
persoon en die gebeurtenissen ook te veranderen. Het onderste deel laat alle gelijkaardige
gebeurtenissen zien die opgeslagen zijn in het gegevensbestand. Het bovenste deel laat
de details zien van het huidig geselecteerde gebeurtenis van de lijst ( indien aanwezig).
De knoppen +, Bewerken, en - laten toe om een gebeurtenis toe te voegen, aan te passen
of te verwijderen van het gegevensbestand. Deze knoppen +, Bewerken, en - zijn enkel
beschikbaar indien een gebeurtenis daadwerkelijk wordt gekozen uit de lijst.

Namen The Names tab lets you view and edit any alternate names the person may have. The bottom part of the
window lists all alternate names for the person stored in the database. The top part shows the details of
the currently selected name in the list (if any). The buttons +, Edit, and - allow the addition, modification,
and removal of an alternate name from the database. Note that the Edit and - buttons become available
only when an alternate name is selected from the list.

Figuur 3.9. Dialoog aanpassen personen - namen

Wanneer u een nieuwe naam toevoegt of een bestaande naam aanpast, wordt de dialoog Aanpassen naam
getoond. In onderstaand deel wordt deze dialoog beschreven (zie Paragraaf 3.7.9, “Namen”).

Kenmerken The Attributes tab lets you view and assign attributes to the person. You have complete freedom
to define and use attributes. For example, attributes might be assigned to describe the person's
physical characteristics or personality traits.

Note that each attribute listed in the Attribute dialog consists of two parts: the Attribute itself and
a Value associated with that Attribute. This so-called "Parameter-Value" pairing can help you
organize and systematize your research. For example, if you define "Hair color" as an Attribute
for a person, "Hair Color" will become a selectable Attribute for all other people. The Value of
Hair Color for person A might be red, and brown for person B. In similar fashion, you might
define an Attribute like "Generosity" and use the Value of "Enormous" to describe a particularly
generous person.

The bottom part of the dialog window displays the list of all Attributes stored in the database. The
top part shows the details of the currently selected attribute in the list (if any). The buttons +, Edit,
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and - let you add, modify, and remove an attribute record from the database. Note that the Edit
and - buttons become available only when an attribute is selected from the list.

Figuur 3.10. Dialoog aanpassen persoon - kenmerken

Adressen The Addresses tab lets you view and record the various addresses of the person. The bottom part of
the window lists all addresses stored in the database. The top part shows the details of the currently
selected address in the list (if any). The buttons +, Edit, and - allow you to correspondingly add,
modify, and remove an address record from the database. Note that the Edit and - buttons become
available only when an address is selected from the list.

Sommige verslagen laten toe dat enkel bepaalde informatie van levende personen getoond wordt.Zo
kunt u bv. de adressen van zulke personen weglaten.

Figuur 3.11. Dialoog aanpassen persoon - adressen
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Aantekeningen Figuur 3.12. Dialoog aanpassen persoon - aantekeningen

The Notes tab provides a place to record various items about the person that do not fit neatly
into other categories. To add a note or modify existing notes simply edit the text in the text
entry field.

The Format option lets you set the way the note will appear in reports and web pages. If
you select "Flowed," the text generated will have single spaces put in place of all multiple
spaces, tabs, and single end-of-line characters. A blank line inserted between two blocks of
text will signal a new paragraph; additional inserted lines will be ignored.

Indien u de optie 'geformatteerd' kiest, zal de tekst in verslagen en webpagina's exact weer-
gegeven worden zoals ingegeven in de aantekeningendialoog.
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Bronnen Figuur 3.13. Dialoog aanpassen persoon - bronnen

The Sources tab allows you to view and document the sources for the information you collect. These
might be general sources that do not describe a specific event, but which nevertheless yield informa-
tion about the person. For example, if Aunt Martha's memoirs mention her great-grandson Paul, the
researcher may assume that this Paul actually existed and cite Aunt Martha's memoirs as the source
that justifies this assumption.

Tip

Bronnen die specifieke gebeurtenissen documenteren, worden best onder bronnen van
deze gebeurtenis opgeslagen ( onder de Gebeurtenis tab) in plaats van als een bron van
een bepaalde persoon. De tab Bronnen bij een persoon kan best gebruikt worden voor
alle bronnen die niet specifiek verbonden zijn met andere gegevens.

The central part displays the list of all source references stored in the database in relation to the person.
The buttons +, Edit, and - allow you to correspondingly add, modify, and remove a source reference
to this person. Note that the Edit and - buttons become available only when a source reference is
selected from the list.

Galerij The Gallery tab lets you view and store photos, videos, and other media objects that are associated
with the person. The central part of the window lists all such media objects. Any object in the form of
a valid image file will result in the display of a thumbnail view of the image. For other objects such
as audio files, movie files, etc., a corresponding file type icon is displayed instead.

Tip

Het eerst beschikbare beeld in de galerij zal getoond worden in het Beeld venster in
tab Algemeen.

The buttons +, Select, Edit, and - let you add a new image to the database, link to an image already
stored in the database, modify an image, and remove a given media object from the person's gallery.
Note that the Edit and - buttons become available only when a media object is selected from the list.
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Figuur 3.14. Dialoog aanpassen persoon - galerij

Opmerking

Wanneer een media object verwijderd uit de galerij van een persoon, wordt dit bestand
niet verwijderd uit het gegevensbestand. Enkel de verwijzing naar dit object wordt ver-
wijderd uit de gegevens van de persoon.

Internet De tab Internet, geeft de internet-adressen die relevant zijn voor de persoon. Het onderste deel geeft
een lijst van alle internet-adressen en bijhorende beschrijvingen. Bovenste deel toont de details van
het huidige geselecteerde adres uit de lijst(indien aanwezig). De knoppen +, Bewerken, en - laten
toe om een internet-adres toe te voegen, aan te passen of te verwijderen.
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Figuur 3.15. Dialoog aanpassen persoon - internet

Associaties De tab Associaties toont informatie over associaties tussen mensen in het gegevensbestand en
laat u toe deze informatie te wijzigen. Deze associaties kunnen vrienden van de familie zijn,
peter en meter of gelijk welke andere associatie die u wenst op te slaan.

Figuur 3.16. Dialoog persoonsassociaties bewerken

LDS The LDS (Latter Days Saints) tab lets you view and edit information about LDS ordinances of the person.
These are LDS Baptism, Endowment, and Sealed to Parents ordinances, as labeled inside the tab. Each
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ordinance is described by its date, LDS temple, and Place where it happened. An additional pop-up menu,
"Parents," is available for the Sealed to Parents ordinance. Each ordinance can be further described through
the selections available in the Status pop-up menu. It can also be include notes and references to sources
through the corresponding Sources... and Note buttons.

Figuur 3.17. Dialoog persoon - LDS bewerken

3.7.2. Datums aanpassen

Dit deel beschrijft hoe datums in te voeren en aan te passen. Omdat datums zo belangrijk zijn voor genealogisch
onderzoek, zorgt GRAMPS er voor om alle datum informatie te bewaren en te gebruiken.

Informatie kan ingegeven worden in een datumveld door rechtstreeks de datum in te typen in dit veld of door de
dialoog datumselectie op te roepen. Beide methoden worden later uitgelegd maar eerst zullen we enkele belangrijke
datumeigenschappen in GRAMPS bespreken.

3.7.2.1. Datumtypes

Datums worden in GRAMPS volgens de volgende types onderverdeeld:

Regulier Een "reguliere" datum is een datum die een specifieke dag, datum of maand bevat. Deze datum kan
volledig zijn (bijv. 6 Juni 1990) of onvolledig (bijv. Juli 1977).

Voor Een datum van het type "voor" kan enkel geïdentificeerd worden als voorkomend voor een bepaalde
dag, maand of jaar.

Na Een "na" datum is een datum die na een bepaalde dag, maand of jaar valt.

Bereik Een "bereik" beschrijft een periode waarin de gebeurtenis plaatsvond. Voorbeeld, "tussen Januari
1932 en Maart 1940."

Van tot Een "van tot" beschrijft een tijdsperiode waarin de gebeurtenis bestond. Voorbeeld, "van 12 Mei
1999 tot 2 Februari 2002."
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3.7.2.2. Datumformaten en vertaalregels

GRAMPS herkent ingevoerde datums in verscheidene formaten. Het standaard numeriek formaat wordt bepaald
door de omgeving waarin GRAMPS draait. Dus DD.MM.YYYY voor de meeste Europese landen en MM/DD/
YYYY voor de V.S. enz.

Naast exacte datums kan GRAMPS ook verscheidene datums herkennen die niet regulier zijn: voor, na, rond,
bereik en periode. Ook wordt de kwaliteit begrepen : berekend of geschat. Tenslotte worden gedeeltelijke datums
en vele alternatieve kalenders ondersteund. Verderop vindt u een lijst van de ingaveregels om een juiste datum-
vertaling te verkrijgen.

Datum vertaalregels

Deze lijst is enkel van toepassing op de Engelstalige versie van GRAMPS. Indien u gebruikt maakt
van locale versies, kan het zijn dat bijkomende vertaalregels voorhanden zijn. Momenteel zijn spe-
ciale vertaalregels beschikbaar voor Frans, Duits, Russisch, Fins, Nederlands en Spaans.

Indien de locale vertaler aanwezig is in uw versie kan het dus zijn dat andere regels van toepassing
zijn. Indien er geen duidelijk handleiding te vinden is? kan je instinctief een aantal normale en gang-
bare datums invoeren. Indien er niets gaan, gebruik dan best de Datum selectie dialoog.

• Enkelvoudige reguliere datums kunnen zo ingevoerd worden zoals u ze schrijft. Voorbeelden: 24 Mei, 1691
of 1 Januari 2007.

• Andere datums moeten starten met een kwaliteit: geschat of berekend, indien van toepassing. Voorbeeld:
gesch. 1962 of ber. 2007. (Opmerking: er moet geen kwaliteit opgegeven te worden voor reguliere datums.)

• Na de kwaliteit volgt het type. Indien het type voor, na, of rond is, kunt u dit invoeren door "voor", "na" of
"rond" te typen. Indien het type een bereik is, schrijft u "tussen DATUM en DATUM", en als het type een
periode is, schrijft u "van DATUM tot DATUM". DATUM is hier een enkele datum.

Voorbeelden: geschat van 2002 tot 2006, voor Juni 1975, geschat rond 2000, berekend tussen Mei 1900 en
Januari 1990.

• Gedeeltelijke datums kunnen ingevoerd worden door eenvoudig de ontbrekende informatie weg te laten. Voor-
beelden: Mei 1699 en 2009.

• Alternatieve kalenders zijn kalenders die afwijken van de Gregoriaanse. Momenteel ondersteunt GRAMPS
volgende kalenders: Hebreeuwse, Franse Republiek, Juliaanse, Islamitische en Perzische kalenders. Om een
kalender op te geven die afwijkt van de standaard Gregoriaanse, voegt u de naam van de kalender to aan de
datumtekenreeks, v.b. "9 Januari 1905 (Juliaans)".

3.7.2.3. Indicatie van de geldigheid van een datum

GRAMPS maakt gebruik van gekleurde cirkels om de juistheid van ingevoerde datums weer te geven.

Datum led-knoppen

De gekleurde cirkels worden ook als led-knoppen aangegeven. Klik op een led-knop en er wordt
een dialoog Datum selectie getoond, die hieronder in detail wordt beschreven, zie Paragraaf 3.7.2.4,
“Grafische gebruikers-interface om datums in te geven”

• Een groene cirkel betekent dat de datum volledig en geldig is (v.b. 24 Mei 1961). Eenvoudig gezegd, groen
wil zeggen dat de datum overeenstemt met een unieke datum.

• Een gele cirkel geeft aan dat de datum geldig is, maar geen het geen reguliere datum is. Dit kan aangeven dat de
datum van een ander type is: een voor.. datum( voor 1 Mei 1960) of een na... datum (na 1 Mei 1960) of rond ...
datum (rond 23 Mei 2005), of een bereik (tussen 2 Mei 1963 en 3 Mei 1964) of een periode (van 2 Mei 1599 tot
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3 Juni 1603). Het kan ook gaan over een complete datum, maar met de kwaliteit geschat of berekend. Tenslotte
kan het gaan over een gedeeltelijke datum, dus een reguliere datum waarin een deel ontbreekt, v.b. Juni 2005.

Zelfs als de gedeeltelijke datums geen unieke dagen omvatten, kunnen ze toch gebruikt worden voor sommige
vergelijken tussen datums.

• Een rode cirkel geeft aan dat de ingevoerde datum niet herkend wordt als een geldige datum (v.b. "Kerstweek
van 62" of "de zomer toen ik werd geopereerd"). In zulke gevallen zal de datum als een teksttekenreeks worden
opgeslagen en kan er daarom ook geen vergelijk met andere datums gebeuren. Zoals u zelf vaststelt is het beter
de teksttekenreeksen te vermijden. In bovenstaande gevallen is het dus beter om de datum in te voeren als
volgt: "December 1962" en dan een opmerking toe te voegen "Kerstweek van '62."

3.7.2.4. Grafische gebruikers-interface om datums in te geven

Bovenstaande vertaalregels geven u een idee hoe u best de meeste datums invoert, maar u kunt ook gebruik maken
van Datum selecteren dialoog. Deze dialoog is zeker handig indien u een complexe datum wenst in te voeren of
eenvoudigweg om te controleren of de ingevoerde informatie voor GRAMPS verstaanbaar is. De Datum selecteren
dialoog kan ook opgeroepen worden door op de gekleurde led-knop naast het datum ingaveveld te klikken.

Figuur 3.18. Dialoog voor keuze van de datum

The Calendar menu lets you choose a calendar other than the default Gregorian. The Quality menu gives you the
choices of Regular, Estimated, or Calculated. The Type menu allows you establish the exact date type: Regular,
Before, After, About, Range, Span, and Text only. You can set the Date by setting the day, the month, and the year.
In the event that your date type is Range or Span, the Second date will be activated. Finally, the Text comment
text entry field allows storing an arbitrary text string along with the date.

Opmerking

If you have an important comment to make about a date, you are better off doing so in a Note that
corresponds to the event than in the Text comment field of the Date selection dialog. We recommend
this for the following reason: If you enter a date by typing it directly into the date field (that is, not
via the Date selector dialog), your entry will be copied and stored as the text comment string when
GRAMPS parses the entered text. Thus, any comment that may have been there prior to the parsing
will be overwritten.
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3.7.3. Relatie-informatie bewerken

Information about relationships is entered and edited through the Family Editor dialog. This dialog may be invoked
in a number of ways:

• From Relationships View: click on an Edit button in the family that you want to edit.

• From Family List View: select the family in the list and then click the Edit button on the Toolbar, or double-
click on the family.

• From Pedigree View: point your mouse over the black line connecting the spouses, right-click and select Edit
from the context menu, or double-click on the black line.

Any of these methods will prompt you with the following Family Editor dialog:

Figuur 3.19. Family Editor dialog

The top of the window shows the names of the people whose relationship is being edited, as well as their birth
and death information. The main part of the window displays three Relationship Information fields and the seven
notebook tabs representing different categories of information about the relationship. Click any tab to view or
edit the information it contains. The bottom part has OK and Cancel buttons. Clicking the OK button at any time
will apply all the changes made in all tabs and close the dialog window. Clicking the Cancel button at any time
will close the window without applying any changes. If any of the data in any tab is modified, an alert window
will appear that will prompt you choose between closing the dialog without saving changes, canceling the initial
cancel request, or saving the changes.

Opmerking

Clicking OK will immediately save changes to the database. This version of GRAMPS does not have
a separate saving function, all changes are immediate.
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Tip

Wanneer een opschrift van een tab vet gedrukt is, wil dit zeggen dat er informatie opgeslagen is.

The Relationship Information section fields have the basic desciption of the relationship. The GRAMPS ID field
displays the ID number which labels this relationship in the database. The available types (such as Married, Un-
married, etc.) can be chosen from the drop-down Relationship type menu. The Marker allows you to specify some
basic information on the status of your research.

De tabs geven de volgende informatiecategorieën over relaties:

Children The Children tab lets you view and edit the list of children in this relationship. The +
button allows entering a new person to the database and adding that person as a child in
this relationship. The Select button lets you select an existing person to be a child in the
relationship. The Edit button allows for editing the relations between the selected child and
the parents. Finally, the - lets you remove the selected child from the relationship. Note
that the Edit and - buttons become available only when a child is selected from the list.

Opmerking

Removing a child from the list does not delete that child from the database.
It simply removes the child from this relationship.

Gebeurtenissen The Events tab lets you view and edit the list of events relevant to the relationship. The
buttons +, Edit, and - let you add, modify, or remove an event record from the database.
Note that the Edit and - buttons become available only when an event is selected from
the list.

Opmerking

Removing an event from the list does not delete that event from the database.
It simply removes the event reference from this relationship.

Bronnen The Sources tab lets you view and edit a list of references to the sources that provide
evidence for the relationship. These might be documents that refer to the relationship, but
which do not necessarily document it officially. For example, if Aunt Martha's memoirs
mention that her great-grandson Paul was married, the researcher may take this as evidence
of the relationship between Paul and his wife existed and cite the memoirs as the source
for this assumption.

Tip

Bronnen die specifieke gebeurtenissen zoals huwelijken of scheidingen do-
cumenteren, werden best verzameld onder de tab "gebeurtenissen" en ver-
bonden met deze gebeurtenissen

The buttons +, Edit, and - allow let you add, modify, and remove a source reference to
this relationship. Note that the Edit and - buttons become available only when a source
reference is selected from the list.

Opmerking

Removing an entry from the list does not delete that source from the database.
It simply removes the source reference from this relationship.

Kenmerken The Attributes tab lets you view and edit particular information about the relationship that
can be expressed as attributes. The buttons +, Edit, and - let you add, modify, or remove
an attribute. Note that the Edit and - buttons become available only when an attribute is
selected from the list.
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Aantekeningen The Notes tab lets you view and edit notes associated with the relationship. These could
be any comments which do not naturally fit into the "Parameter-Value" pairs available to
Attributes. To add a note or modify existing notes simply edit the text in the text entry field.

The Format option lets you set the way the note will appear in reports and web pages. If
you select Flowed, the text generated will have single spaces put in place of all multiple
spaces, tabs, and single end-of-line characters. A blank line inserted between two blocks
of text will signal a new paragraph; additional inserted lines will be ignored.

Indien u de optie 'geformatteerd' kiest, zal de tekst in verslagen en webpagina's exact weer-
gegeven worden zoals ingegeven in de aantekeningendialoog.

Galerij The Gallery tab lets you store and display photos and other media objects associated with
the relationship. The central part of the window lists all such objects and gives you a thumb-
nail preview of image files. Other objects such as audio files, movie files, etc., are repre-
sented by a generic GRAMPS icon. The buttons +, Select, Edit, and - let you add a new
image, add a reference to an existing image, modify an existing image, and remove a me-
dia object's link to the relationship. Note that the Edit and - buttons become available only
when a media object is selected from the list.

LDS The LDS (Latter Days Saints) tab displays information about the LDS Sealed to Spouse
ordinance. The data can include date, LDS temple, and Place. The status of the ordinance
can be described through the selections available in the Status pop-up menu and can also
be referenced in the corresponding Sources... and Note buttons.

3.7.4. Broninformatie bewerken

To edit source data, switch to the Sources View and select the desired entry in the list of sources. Double-click
that entry or click the Edit icon on the toolbar to invoke the following Source Editor dialog:
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Figuur 3.20. Dialoog bronnen bewerken

The main part of the window displays four notebook tabs containing different categories of information. Click a
tab to view or edit its contents. The bottom part of the window has OK and Cancel buttons. Clicking OK will apply
all the changes made in all tabs and close the dialog window. Clicking the Cancel button will close the window
without applying any changes.

Opmerking

OK aanklikken zal de veranderingen aan het gegevensbestand onmiddellijk bewaren ( worden naar
de schijf geschreven). Veranderingen worden ogenblikkelijk doorgevoerd.

Tip

Wanneer een opschrift van een tab vet gedrukt is, wil dit zeggen dat er informatie opgeslagen is.

The general information at the top of the window lets you define basic information about the source: its Title,
Author, Abbreviation, and Publication information. You can type this information directly into the adjacent fields.

The tabs provide the following information categories of source data:

Aantekeningen The Note tab provides a place to record various information about the source that does not
fit neatly into other categories. To add a note or modify existing notes simply edit the text
in the text entry field.

Galerij The Gallery tab lets you store and display photos and other media objects associated with a given
source (for example, a photo of a birth certificate). The central part of the window lists all such media
objects and gives you a thumbnail preview of image files. Other objects such as audio files, movie
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files, etc., are represented by a generic GRAMPS icon. The buttons +, Select, Edit, and - let you add
a new image, add a reference to an existing image, modify an existing image, and remove a media
object's link to the source. Note that the Edit and - buttons become available only when a media object
is selected from the list.

Gegevens The Data tab displays "Key/Value" pairs that may be associated with the source. These are similar to
the "Attributes" used for other types of GRAMPS records. The difference between these Key/Value
pairs and Attributes is that Attributes may have source references and notes, while Key/Value data
may not.

The central part of the window lists all existing Key/Value pairs. The buttons + and - let you add
and remove pairs. To modify the text of Key or Value, first select the desired entry. Then click in
either the Key or Value cell of that entry and type your text. When you are done, click outside the
cell to exit editing mode.

Bibliotheken The Repositories tab displays the references to the repositories in which the source is con-
tained. The list can be ordered by any of its column headings: ID, Title, Call Number,and
Type. Double-clicking an entry allows you to view and edit the record. You may also edit the
reference. The buttons on the side of the tab allow you add a new repository, link to (or share)
an existing repository, edit the reference to the repository, or remove the reference.

Referenties The References tab lists all the database records that refer to this source, if any. The list can be
ordered by any of its column headings: Type, ID, or Name. Double-clicking an entry allows
you to view and edit the record.

Opmerking

Enkel de primaire objecten kunnen getoond worden in de tab Referenties : per-
soon, familie,gebeurtenis, locatie of media-object. Secundaire objecten zoals na-
men en attributen kunnen enkel bereikt worden via de primaire objecten waartoe
ze behoren.

3.7.5. Locatie-informatie bewerken

To edit information about places, switch to the Places View and select the desired entry from the list of places.
Double-click that entry or click the Edit button on the toolbar to bring up the following Place Editor dialog:
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Figuur 3.21. Dialoog locatie bewerken

The main part of the window displays seven notebook tabs containing different categories of information. Click
a tab to view or edit its contents. The bottom part of the window has OK and Cancel buttons. Clicking OK will
apply all the changes made in all tabs and close the dialog window. Clicking the Cancel button will close the
window without applying any changes.

Opmerking

Klikken op de OK knop zal de wijzigingen aan het gegevensbestand direct opslaan. Alle aanpassin-
gen gebeuren onmiddelijk.

Tip

Wanneer een tabopschrift vet gedrukt is en een icoontje toont, betekent dit dat de tab gegevens bevat.
Indien dit niet zo is, zijn er geen gegevens.

De tabs vertegenwoordigen volgende categorieën van locatiegegevens:

Algemeen The General tab you view and edit the basic information about the place: the Title which labels it in
the database, City, Church parish, County, State, Country, Longitude, and Latitude. You can type
this information directly into the adjacent fields.

Andere namen The Other names tab lets you view and edit other names by which the place might be known.
The bottom part of the window lists all other names of the place stored in the database. The
top part of the window shows the details of the currently selected name in the list (if any).
The buttons +, Edit, and - let you add, modify, and remove a name record. Note that the Edit
and - buttons become available only when a name is selected from the list.
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Aantekeningen De tab Opmerkingen geeft alle commentaren of opmerkingen ivm. de locatie. Om een op-
merking toe te voegen of een bestaande aan te passen kunt u eenvoudig de tekst in het tek-
stingaveveld veranderen.

Bronnen The Sources tab lets you view and edit sources relevant to a place. The central part of the window lists
all such source references stored in the database. The buttons +, Edit, and - let you add, modify, and
remove a source reference associated with a place. Note that the Edit and - buttons become available
only when a source reference is selected from the list.

Galerij The Gallery tab lets you store and display photos and other media objects associated with a given
place. The central part of the window lists all such media objects and gives you a thumbnail preview of
image files. Other objects such as audio files, movie files, etc., are represented by a generic GRAMPS
icon. The buttons +, Select, Edit, and - let you add a new image, add a reference to an existing image,
modify an existing image, and remove a media object's link to the place. Note that the Edit and
- buttons become available only when a media object is selected from the list.

Internet The Internet tab contains Internet addresses relevant to the place. The bottom part of the window
lists all such Internet addresses stored in the database. The top part shows the details of the currently
selected address in the list (if any). The buttons +, Edit, and - let you add, modify, and remove an
Internet address. The Go button (represented by an icon with a green arrow and yellow circle) opens
your browser and takes you to the web page corresponding to the highlighted Internet address. Note
that the Edit, -, and Go buttons become available only when an address is selected from the list.

Referenties The References tab indicates any database records (events or LDS ordinances) that refer to a
place. This information cannot be modified from the Place Editor dialog. Instead, the corres-
ponding database record (e.g., a birth event) has to be brought up and its place reference edited.

3.7.6. Media-objecten informatie bewerken

To edit media data, switch to the Media View and select the desired entry in the list of sources. Double-click on
that entry or click Edit on the toolbar to invoke the following Media Properties Editor dialog:
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Figuur 3.22. Dialoog Mediakenmerken bewerken

A thumbnail preview of the object is presented, along with a summary of its properties (ID, path, and object type).
The central part of the window displays five notebook tabs containing different categories of information. Click
a tab to view or edit its contents. The bottom part of the window has OK and Cancel buttons. Clicking OK will
apply all the changes made in all tabs and close the dialog window. Clicking the Cancel button will close the
window without applying any changes.

Opmerking

OK aanklikken zal de veranderingen aan het gegevensbestand onmiddellijk bewaren ( worden naar
de schijf geschreven). Veranderingen worden ogenblikkelijk doorgevoerd.

Tip

Wanneer een opschrift van een tab vet gedrukt is, wil dit zeggen dat er informatie opgeslagen is.

De tabs geven de volgende categorieën van mediagegevens:

Algemeen The General tab lets you view and edit the object's Title and Date. You can type this information
directly into the corresponding fields. For the Date, you can also enter information by clicking the
LED button and invoking the Date selection dialog.
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Opmerking

Every media object is referred to by its Path. The user is responsible for keeping track
of the object files. GRAMPS will only reference and display the contents, not manage
the files themselves.

Kenmerken The Attributes tab lets you view and edit particular information about the media object that can
be expressed as Attributes. The bottom part displays the list of all such attributes stored in the
database. The top part shows the details of the currently selected attribute in the list (if any). The
buttons +, Edit, and - let you add, modify, or remove an attribute. Note that the Edit and - buttons
become available only when an attribute is selected from the list.

Aantekeningen The Note tab provides a place to record various information about the source that does not
fit neatly into other categories. This area is particularly useful for recording information that
does not naturally fit into the "Parameter/Value" pairs available to Attributes. To add a note
or modify existing notes simply edit the text in the text entry field.

Referenties The References tab indicates any database records that refer to a given media object. The list
can be ordered according to any of its column headings: Type, ID, or Name. Double-clicking
an entry allows you to view and edit the corresponding record.

Opmerking

Only primary objects can be shown in the References tab: Person, Family, Event,
Source, or Place. The secondary objects such as Names and Attributes, although
able to refer the media object, will only show up through their primary objects
to which they belong.

3.7.7. Gebeurtenisseninformatie bewerken

Events are edited through the Event Editor dialog. This dialog can be accessed from either the Edit Person dialog
or the Marriage/Relationship dialog.

Figuur 3.23. Dialoog gebeurtenissen bewerken

The central part of the window displays five notebook tabs containing different categories of information. Click
a tab to view or edit its contents. The bottom part of the window has OK and Cancel buttons. Clicking OK will
apply all the changes made in all tabs and close the dialog window. Clicking the Cancel button will close the
window without applying any changes.

Tip

Wanneer een opschrift van een tab vet gedrukt is, wil dit zeggen dat er informatie opgeslagen is.

De tabs geven de volgende informatiecategorieën ivm. gegevens van gebeurtenissen:

Algemeen The General tab lets you view and edit basic information about the event: its Type, Date, Place,
Cause, and Description. You can type this information directly into the adjacent fields. The type
can be selected from available types listed in the Event type drop-down menu. The rest of the
information can be typed in the appropriate text entry fields. Checking the Private record box marks
the event record as private and allows it to be omitted from reports.

Bronnen The Sources tab lets you view and edit sources relevant to an event. The central part of the window
lists all such source references stored in the database. The buttons +, Edit, and - let you add, modify,
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and remove a source reference associated with a place. Note that the Edit and - buttons become
available only when a source reference is selected from the list.

Aantekeningen The Note tab provides a place to record notes or comments about the event. To add a note
or modify existing notes simply edit the text in the text entry field.

3.7.8. Bronreferenties bewerken

Source references connect a Source to another object and allow you to provide additional information about the
source. When adding source references to events, places, etc., the following dialog appears:

Figuur 3.24. Dialoog broninformatie bewerken

The dialog includes two main headings, Source selection and Source details. Source selection displays the Title of
the Source, its Author, and Publication information. The Title can be selected from the available sources listed in
the drop-down menu. If the source you are referencing is not already in the database, you can enter it by clicking
New... and filling out the invoked Source Editor dialog.
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The Source details section indicates the details associated with the particular reference to this Source: Confidence,
Volume/Film/Page, Date, Text, and Comments. You can choose the Confidence level from the Confidence drop-
down menu. The remaining details can be typed in the corresponding text entry fields.

Tip

Information in this dialog is specific to the particular reference. A single source can be referenced
many times, and all such references will have in common the overall source information. This dialog
lets you provide reference-specific data, such as relevant quotes, comments, confidence, page num-
bers, etc., to further specify and document the reference.

3.7.9. Namen
Names are edited through the following Name Editor dialog:

Figuur 3.25. Dialoog namen bewerken

The top of the window shows the dialog title including the name of the person whose name is being edited. The
central part of the window displays three notebook tabs containing different categories of available information.
You can bring any tab to the top for viewing or editing by clicking on the appropriate tab heading. The bottom part
has OK and Cancel buttons. Clicking the OK button at any time will apply all the changes made in all tabs and close
the dialog window. Clicking the Cancel button at any time will close the window without applying any changes.

Tip

The tab labels reflect the presence of corresponding information: if the tab contains any data, its label
appears boldface; if the tab has no data then its label appears regular (not bold).
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The tabs provide the following information categories of the name data:

Algemeen The General tab allows editing of general information about the name: given name, family name,
patronymic (a form of father's name used in some languages, e.g. Russian), family prefix, suffix,
title, and type of the name. The information can be typed in the appropriate text entry fields. The
family name and the type can be also selected from available choices listed in the appropriate drop-
down menus.

Options allow you to adjust specific grouping, sorting, and displaying properties of this name, as
well as to provide the date corresponding to the name. The Grouping field provides an alternative
grouping node for a given name, overriding the default grouping based on the family name. This
may be necessary with similar family names that need to be grouped together -- for example Russian
names Ivanov and Ivanova are considered the same, but difference in gender is reflected in different
spelling. To enable typing into this field, check the Override check button. The Sort as and Display
as determine the manner in which the name appears in the People View and in the reports. The Date
can provide information on the validity of this name -- use spans as necessary. Check the Private
record box to mark this name record as private. This will give you a chance to omit this name from
being included in reports, if you choose so among the report generation options.

Bronnen The Sources tab displays information about sources relevant to this name and controls allowing its
modification. The central part displays the list of all such sources' references stored in the database.
The buttons +, Edit, and - allow you to correspondingly add, modify, and remove a source reference
to this name. Note that the Edit and - buttons become available only when a source reference is
selected from the list.

Aantekeningen De tab Opmerking toont alle opmerkingen betreffende de naam. Om een opmerking toe te
voegen of een bestaande aan te passen kunt u eenvoudigweg de tekst in het tekstingaveveld
veranderen.

The Format option allows you to set the appearance of the note in the output (i.e. in reports
and web pages). Selecting Flowed will replace all multiple spaces, tabs, and single end-of-
line characters with single space in the output. The two consecutive new lines (i.e. an empty
line) denote a new paragraph. Selecting Preformatted will honor all multiple spaces tabs,
and new lines, so that the output will appear as it is entered into the text entry field.

3.7.10. Kenmerken

Kenmerken worden bewerkt via de volgende Bewerken kenmerken dialoog:
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Figuur 3.26. Dialoog kenmerken bewerken

The top of the window shows the dialog title including the name of the person whose attribute is being edited. The
central part of the window displays three notebook tabs containing different categories of available information.
You can bring any tab to the top for viewing or editing by clicking on the appropriate tab heading. The bottom part
has OK and Cancel buttons. Clicking the OK button at any time will apply all the changes made in all tabs and close
the dialog window. Clicking the Cancel button at any time will close the window without applying any changes.

Tip

The tab labels reflect the presence of corresponding information: if the tab contains any data, its label
appears boldface; if the tab has no data then its label appears regular (not bold).

De tabbladen geven de volgende informatiecategorieën over de gegevens van de kenmerken:

Algemeen The General tab allows editing of the most general information about the attribute: name of the
attribute and its value. The information can be typed in the appropriate text entry fields. The attribute
name can also be selected from available choices (if any) listed in the Attribute drop-down menu.
Check the Private record box to mark this attribute record as private. This will give you a chance to
omit this attribute from being included in the reports, if you choose so among the report generation
options.

Bronnen The Sources tab displays information about sources relevant to this attribute and controls allowing its
modification. The central part displays the list of all such sources references stored in the database.
The buttons +, Edit, and - allow you to correspondingly add, modify, and remove a source reference
to this attribute. Note that the Edit and - buttons become available only when a source reference is
selected from the list.

Aantekeningen De tab Opmerking toont alle opmerkingen betreffende een kenmerk. Om een opmerking toe
te voegen of een bestaande aan te passen kunt u eenvoudigweg de tekst in het tekstingaveveld
veranderen.
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The Format option allows you to set the appearance of the note in the output (i.e. in reports
and web pages). Selecting Flowed will replace all multiple spaces, tabs, and single end-of-
line characters with single space in the output. The two consecutive new lines (i.e. an empty
line) denote a new paragraph. Selecting Preformatted will honor all multiple spaces tabs,
and new lines, so that the output will appear as it is entered into the text entry field.

3.7.11. Adressen
Addresses are edited through the following Address Editor dialog:

Figuur 3.27. Dialoog Aanpassen Adressen

The top of the window shows the dialog title including the name of the person whose address is being edited. The
central part of the window displays three notebook tabs containing different categories of available information.
You can bring any tab to the top for viewing or editing by clicking on the appropriate tab heading. The bottom part
has OK and Cancel buttons. Clicking the OK button at any time will apply all the changes made in all tabs and close
the dialog window. Clicking the Cancel button at any time will close the window without applying any changes.

Tip

The tab labels reflect the presence of corresponding information: if the tab contains any data, its label
appears boldface; if the tab has no data then its label appears regular (not bold).

The tabs provide the following information categories of the address data:

Algemeen The General tab allows editing of the most general information about the address: date, street ad-
dress, city or county, state or province, country, the postal code, and the phone number. The infor-
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mation can be typed in the appropriate text entry fields. Check the Private record box to mark this
address record as private. This will give you a chance to omit this address from being included in
reports, if you choose so among the report generation options.

Bronnen The Sources tab displays information about sources relevant to this address and controls allowing its
modification. The central part displays the list of all such sources references stored in the database.
The buttons +, Edit, and - allow you to correspondingly add, modify, and remove a source reference
to this address. Note that the Edit and - buttons become available only when a source reference is
selected from the list.

Aantekeningen De tab Opmerking toont alle opmerkingen betreffende het adres. Om een opmerking toe te
voegen of een bestaande aan te passen kunt u eenvoudigweg de tekst in het tekstingaveveld
veranderen.

The Format option allows you to set the appearance of the note in the output (i.e. in reports
and web pages). Selecting Flowed will replace all multiple spaces, tabs, and single end-of-
line characters with single space in the output. The two consecutive new lines (i.e. an empty
line) denote a new paragraph. Selecting Preformatted will honor all multiple spaces tabs,
and new lines, so that the output will appear as it is entered into the text entry field.

3.7.12. Gegevens samenvoegen

Sometime several records in the database turn out to be describing the same object: same person, same place, or
same source. It could happen either when the data is entered twice by mistake, or when new information reveals
that the two entries refer to the same person. It can also happen after importing GEDCOM obtained from a relative,
whose database overlaps with your existing data.

Whenever you detect duplicate records, merging them a useful way of correcting the situation.

Tip

To make a merge, exactly two records have to be selected in the appropriate view (People View,
Sources View, or Places View). This is accomplished by selecting one entry and then selecting ano-
ther person while holding down Ctrl key.

3.7.12.1. Personen samenvoegen

There are two ways of merging personal records: Compare and Merge and Fast Merge, both available from the
Edit menu.

Opmerking

Merging people does not discard any information with either method. The decisions you make during
the merge only affect which data will become primary and which will become secondary for the
resulting merged record.

Vergelijken en samenvoegen When exactly two people are selected, choose Edit->Compare and Merge...
to invoke Compare People dialog.
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Figuur 3.28. Dialoog personen vergelijken

The dialog allows you to make a decision on whether or not the selected
records should be merged. If you decide that the records should not be mer-
ged, despite similar names, you may click Cancel to close the dialog wit-
hout making any changes. If you decide to proceed with merging, select
the appropriate Select radio button to specify the record to be used as the
source of primary data, then click Merge and close.

The data from the other record will be kept as alternate data. Specifically,
all names from the other record will become alternate names of the merged
record. Similarly, parents, spouses, and children of the other record will
become alternate parents, spouses, and children of the merged record, and
so on.

Snel samenvoegen When exactly two people are selected, choose Edit->Fast Merge to invoke Merge Pe-
ople dialog.

Figuur 3.29. Merge People dialog

The dialog allows you to quickly merge two records, specifying the record to be used
as the source of primary data. The data from the other record will be kept as alternate
data. Specifically, all names from the other record will become alternate names of the
merged record. Similarly, parents, spouses, and children of the other record will become
alternate parents, spouses, and children of the merged record, and so on.
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Tip

If you are not certain whether or not you need to merge the records, or
which record to specify as the source of primary data, use Compare and
Merge method described above..

3.7.12.2. Samenvoegen Bronnen

When exactly two sources are selected, choose Edit->Compare and Merge... to invoke Merge Sources dialog.

Figuur 3.30. Dialoog Samenvoegen Bronnen

The dialog allows you to make a decision on whether or not the selected records should be merged. If you decide
that the records should not be merged, despite similar titles, you may click Cancel to close the dialog without
making any changes. If you decide to proceed with merging, choose the appropriate radio button to specify the
title, author, abbreviated title, publication information, and the ID to be used for the merged record, then click OK.

3.7.12.3. Samenvoegen locaties

When exactly two places are selected, choose Edit->Compare and Merge... to invoke Select title dialog.

Figuur 3.31. Merge Places dialog

The dialog allows you to make a decision on whether or not the selected records should be merged. If you decide
that the records should not be merged, despite similar titles, you may click Cancel to close the dialog without
making any changes. If you decide to proceed with merging, choose the appropriate radio button to specify the
title of the merged record, or specify Other and enter new text, then click OK.
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3.8. Navigatie
As long as any database is open, GRAMPS is focused on a single person usually referred to as an Active Person.
This allows you to view or modify the data concerning this person, his or her immediate family, etc. Navigating in
the database (i.e. moving from person to person) is in fact nothing else but changing the Active Person. This section
describes many alternative ways to navigate through the database using both the complex and the convenient
interfaces GRAMPS provides. All these ways eventually accomplish the same thing, but some are more convenient
than others, depending what you are doing in GRAMPS at the moment.

3.8.1. Personenscherm gebruiken
The most intuitive way to select an Active Person is to use the People View (see Paragraaf 2.1.2, “Personen-
scherm”). When in the People View, just select the name of the desired person from the list by clicking that list en-
try. The person you have selected becomes active. The statusbar updates to reflect the change of the active person.

3.8.2. Familiescherm gebruiken
Wanneer u zich in het familiescherm bevindt, (zie Paragraaf 2.1.3, “Relatiescherm”), kunt u eenvoudig op de
volgende manier navigeren tussen de leden van de getoonde familie:

• To make the currently selected spouse the Active Person, click the double-arrow button to the right of the
Active Person box. Alternatively, right-click into the spouse box and select Make the selected spouse an Active
Person item from the context menu.

• To make the currently selected parents the active family (thereby making father the Active Person and mother
the selected spouse), click the right-arrow button to the right of the active person's parents box. Alternatively,
right-click into the active person's parents box and select Make the selected parents the active family item
from the context menu.

• To make the currently selected spouse's parents the active family (thereby making father the Active Person and
mother the selected spouse), click the right-arrow button to the right of the spouse's parents box. Alternatively,
right-click into the spouse's parents box and select Make the selected parents the active family item from the
context menu.

• To make the currently selected child the Active Person, click the left-arrow button to the right of the children
box. Alternatively, right-click into the children box and select Make the selected child an Active Person item
from the context menu.

In addition to this, GRAMPS provides an extensive set of keyboard navigation options. The detailed reference to
the key bindings is found in the Bijlage B, Sneltoetsreferentie.

3.8.3. Stamboomscherm gebruiken
The Pedigree View (see Paragraaf 2.1.5, “Afstammelingenscherm”) also allows you to move along the family tree.
The benefit of this method is that you can see more than one generation of the family tree. Also, you can jump
directly from a great-grandson to a great-grandfather without going through the intermediate generations.

Note that after changing the Active Person in the Pedigree View, the display is re-adjusted to show up to five
generations, starting from the newly selected Active Person. When in the Pedigree View, you can easily navigate
between the members of the displayed family tree as follows:

• To make any displayed person the Active Person, right-click the corresponding box and choose the first entry
in the context menu.

• To make a child of the currently Active Person (if any) the Active Person, click the left arrow button to the left
of the corresponding box. If there is more than one child, the button expands to the menu listing the children
to choose from.
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• To move the whole family tree one generation back, click on the corresponding right arrow button on the
right-hand side of the display area. Clicking the upper button will move the tree along the paternal line. Clicking
the lower button will move the tree along the maternal line.

Het aanklikken van deze knoppen geeft het zelfde effect als het dubbelklikken op een van de lijnen die zich
links bevinden van de "ouderrechthoeken".

You can also quickly access any of the spouses, siblings, children, or parents of any displayed person. To do this,
move the mouse over the desired person's box and right-click to invoke a context menu. The appropriate menu
items will contain submenus listing all spouses, siblings, children, and parents of the corresponding person.

Voordelen van het gebruik van rechtsklik-menu's

• Directe toegang tot echtgeno(o)t(e) en broers en zussen

• Geeft een volledige lijst van alle leden van alle categorieën en dus niet enkel de geprefeerde leden.

3.8.4. De basispersoon vastleggen

Eén en slechts één persoon kan vastgelegd worden als de 'basispersoon'. Eens deze persoon vastgelegd is, kunt u
snel naar deze persoon navigeren door middel van één enkele klik, ongeacht waar u zich bevindt in de verschillende
schermen.

Gaat u eerst, om de basispersoon vast te leggen,op een willekeurige manier naar deze persoon. Kies dan Edit->Be-
paal basispersoon. Indien u dit gedaan hebt, kunt u va gelijkwaar in het gegevensbestand naar deze persoon gaan
door eenvoudig het Basis icoon inde hulpmiddelenbalk aan te klikken. U kunt ook via het menu Ga->Basis gaan
of van gelijkwelke contextmenu dat beschikbaar is door rechts te klikken en dan Basis te kiezen.

3.8.5. Using history-based tools

GRAMPS also features a powerful set of history-based navigation tools. These tools are similar to those commonly
used in web browsers. They include Back and Forward items available from the Go menu, context menus (available
in People, Family, and Pedigree views), and the toolbar buttons. They also include the list of the recent selections
available under the Go menu that allows you to jump directly to any of the recent selections. Finally, right-clicking
on the Back and Forward toolbar buttons invokes the popup menu with corresponding portion of the history. Select
any item from the menu to jump directly to it.

3.8.6. Personen voorzien van een baldwijzer

Similar to setting the Home person, you can bookmark other people from the database to simplify further naviga-
tion. To bookmark a person, first navigate to that person, then choose Bookmarks->Add bookmark. To move to
that person from anywhere in the database, choose Bookmarks->Go to bookmark->Person's name.

U kunt uw bladwijzers beheren door het kiezen in de menu van Bladwijzers->Bewerken bladwijzers.... Dit geeft
een Bewerken bladwijzers dialoog met een lijst van de bestaande bladwijzers en de mogelijkheden om de lijst
aan te passen.
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Figuur 3.32. Dialoog bladwijzers bewerken

3.8.7. Gegevens terugvinden
To find a record in a database, first switch to the appropriate View that provides the list of the desired records:
People, Sources, Places, or Media. Then start typing the name of a person or the title of a Source, Place, or Media
object that you are looking for, respectively. You may also press Ctrl+F to turn on the search mode, but simply
starting to type is also enough.

Figuur 3.33. Type-ahead find

As you type, the first record in the list that is compatible with your input will be selected.

Personen zoeken

Voor meer complexe opzoekmethoden kunt u filters gebruiken. Het aanzetten van de filtercontrole
gebeurd door het kiezen in de menu van Scherm->Filter, Voor meer details , zie Paragraaf 2.1.2.1,
“Filters”

3.9. Verslagen aanmaken
Reports are the most common form of the output produced by genealogical research. The majority of genealogical
software puts a lot of emphasis on developing nice looking reports. GRAMPS is no exception in this regard,
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offering a choice of a variety of reports. GRAMPS can generate reports in a multitude of open formats, both text
based and graphical. GRAMPS can also produce screen based reports that are convenient for viewing a summary
of your database. Finally, GRAMPS can generate a web site suitable for immediate posting on the Internet. All of
these are almost infinitely flexible. If you wish to modify or extend the default format of GRAMPS report, you
can design and choose the style for each of your reports.

All reports can be accessed through the menu by choosing Reports->Report Type->Particular Report.
Alternatively, you can browse the complete selection of available reports along with their brief descriptions in a
Report Selection dialog invoked by clicking the Reports icon on the toolbar.

3.9.1. Vervangwaarde

Many of the graphical reports allow you to customize the information on the display. Variable substitutions are
used to substitute date for a particular symbol. There are two styles of variables. The difference between the two
styles is how empty data is handled.

The first style of variables are preceeded by a '$'. If the variable evaluates to an empty string, the variable is
replaced with the empty string. The second style of variables are preceeded by a '%'. If the variable evaluates to
an empty string, the line that contains the variable is removed from the output.

$n/%n Toon de persoonsnaam in de vorm van voornaam, achternaam

$N/
%N

Toon de persoonsnaam in de vorm van achternaam, voornaam

$i/%i Toont de geassocieerde GRAMPS ID.

$b/%b Toont de geboortedatum van de persoon

$B/%B Toont de geboorteplaats van een persoon

$d/%d Toont de overlijdensdatum van een persoon

$D/
%D

Toont de plaats van overlijden van een persoon

$s/%s Toont de naam van de echtgenoot van de persoon in de vorm van voornaam achternaam

$S/%S Displays the name of the person's preferred spouse in the form of LastName, FirstName.

$m/
%m

Displays the marriage date of the person and the preferred spouse.

$M/
%M

Toont de locatie verbonden met het huwelijk van de persoon en zijn voorkeursechtgeno(o)t(e).

3.9.2. Boeken

Momenteel is het enige beschikbare verslag onder deze categorie het boekverslag.

Het boekverslag maakt één enkel document aan dat een verzameling van grafische en tekstverslagen bevat. Het
gevolg is dat dit toelaat om een zeer verscheiden verzameling van documenten aan te maken via GRAMPS.

Wanneer boekverslag is gekozen, verschijnt de volgende boekconfiguratiedialoog:
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Figuur 3.34. Boekverslagdialoog

The Book name text entry field is used to save the book (a set of configured selections) for future use. The top
pane lists the items available for inclusion in the book. The bottom pane lists the currently selected items in the
order they will appear in the book.

De horizontale reeks knoppen naast het Boeknaam veld, gelden voor het complete boek. Om alle elementen van
het huidige boek te wissen, klik op de Wis knop. Om het huidige boek (onder de naam ingevuld in het Boeknaam
tekstveld) te bewaren, klik op Bewaren.

Tip

Wanneer het boek opgeslagen wordt, wordt ook de configuratie van elk element bijgehouden.

Click the Open button to load the book from the list of previously saved books. Finally, click the Edit books button
to invoke the editable list of available books.

The vertical set of buttons to the right of the bottom pane operates on the selected book item. Click the Add button
to add selected item from the available list to the current book. Click the Remove button to remove an item from
the current book. Use Up and Down to change the items order in the current book. Click the Setup button to
configure the options of the selected item of the current book.

The configuration dialogs invoked by Setup are item-specific. If you choose not to configure the item, same
defaults will be used for all needed options. The common option for almost all book items is the center person:
the person on whom the item is centered. Thanks to this option, you can create a book with items centered on
different people (e.g. your mom's and dad's ancestors as separate chapters). By default, the center person is set
to the Active Person.

Almost all items available for inclusion in the book are textual or graphical reports, and are therefore available in
the form of standalone reports. The exception is the following items which are only available as book items:

Titelpagina This item produces a customized Title page. You can configure the text of title, subtitle, and
the footer of the page. An image can be optionally placed between the subtitle and the footer.
Because of its configurability, this item can be used to create title pages for the whole book,
its chapter, or even a single item.
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Custom Text This item produces a page with three paragraphs, each containing custom text. The appearance
of the text can be adjusted by using custom styles. This item was meant to be used for epigraphs,
dedications, explanations, notes, and so forth.

3.9.3. Code Generators
This category contains reports that produce files that are meant to be processed by other programs. By themselves,
the files will not provide meaningful information; the files must first be processed by another program. The only
code generator currently available in GRAMPS is the Relationship Graph producing the GraphViz description
of the graph.

The Relationship Graph creates a complex relationship graph in GraphViz format. The GraphViz dot tool can
transform the graph into postscript, jpeg, png, vrml, svg, and other formats. GraphViz tools are freely available
from the GraphViz site [http://www.graphviz.org]. Specific options for this report include filter and number of
generations considered, as well as several GraphViz-specific options related to pagination, color, and details of
the graph.

Tip

If you are not interested in GraphViz code itself and just want to generate graphical output, GRAMPS
can do it for you under the hood. Look for Relationship Graph in the Graphical Reports category,
Paragraaf 3.9.4, “Grafische verslagen”

3.9.4. Grafische verslagen
Graphical reports represent information in forms of charts and graphs. Most of the options are common among
graphical reports, therefore they will be described only once, at the end of this section. The few options which are
specific to a given report will be described directly in that report's entry.

The following graphical reports are currently available in GRAMPS:

Ancestor Chart This report generates the chart of people who are ancestors of the Active
Person. Specific options include the number of generations considered and
the format of the displayed entries.

Ancestor Chart (Wall Chart) This report is similar to the Ancestor Chart report. It provides more options
which make it useful for generating huge charts suitable for a poster or a
wall chart. These options include the ability to compress the report (getting
rid of an empty space) and the option to fit the whole chart on to a single pa-
ge. In the latter case, the contents of the chart is scaled down appropriately.

Afstammelingengrafiek This report generates a graph of people who are descendants of the Active
Person. Specific options include the format of the displayed entries.

Waaiergrafiek This report produces a chart resembling a fan, with Active person in the
center, parents the the semicircle next to it, grandparents in the next semi-
circle, and so on, for a total of five generations.

Relationship Graph This report creates a complex relationship graph in GraphViz format and
then converts into graphical output running it through the the GraphViz dot
tool behind the scene. Specific options for this report include filter, options
for dates and places for the events, and whether to include URLs and IDs for
individuals and families. There are also several GraphViz-specific options
related to pagination, color, and details of the graph.

Statistics Chart This report can collect and display a wealth of statistical data about your
database. Specific options include filter, sorting methods, and additional
birth- and gender-based limit for inclusion into statistics. You can also set
the minimum number of items to qualify for the bar chart, so that the charts

http://www.graphviz.org
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with fewer items will generate a pie chart instead. The Chart Selection tab
allows you to check which charts you want to include in your report.

Tijdslijngrafiek This report outputs the list of people with their lifetimes represented by
intervals on a common chronological scale. Specific options include filter,
sorting method, and the title of the report.

Common options for graphical reports are the filename of the output, the format of the output, selected style, page
size and orientation. Optionally, the reports can be immediately opened with the default application.

Tip

The options used in reports are persistent: each report remembers its options used last time.

3.9.5. Tekstverslagen
Text reports represent the desired information as formatted text. Most of the options are common among text
reports, therefore they will be described only once, at the end of this section. The options which are specific to a
given report will be described directly in that report's entry.

De volgende tekstverslagen zijn momenteel beschikbaar in GRAMPS:

Ahnentafel-verslag This report lists the Active Person and his or her ancestors along with their
vital data. The people are numbered in a special way which is an established
standard called Ahnentafel. The Active Person is given number 1. His or
her father and mother have numbers 2 and 3, respectively. This rule holds
for every person while going back in generations: father's parents are num-
bered 4 and 5, and mother's parents are numbered 6 and 7, fathers always
numbered with even and mothers with odd numbers. Therefore, for any
person having number N in this tree, the numbers of father and mother are
2N and 2N+1, respectively.

Volledig individueel verslag This report provides individual summaries similar to that of the Individual
Summary report. The advantage of this report is the specific filter option.
Depending on the filter choice (Active Person only, his or her descendants,
his or her ancestors, or entire database), the report may contain from one to
many individual summaries. Another option for this report is the inclusion
of source information when listing events.

Comprehensive Ancestors Report This report produces a comprehensive description of ancestors of the Active
Person. The highlights of this report include elaborate layout, images of
children, present and former spouses, and source citations. Specific options:
number of backward generations to consider, whether to cite sources, and
whether to break pages between generations.

Afstammelingenverslag This report produces a brief description of descendants of the Active Per-
son. Specific options: number of forward generations to consider.

Detailed Ancestral Report This report covers in detail the ancestors of the active person. It includes
vital data (birth and death) as well as marriages. Specific options: number of
backward generations to consider, as well as a variety of options regarding
the exact contents to include.

Detailed Descendant Report This report covers in detail the descendants of the active person. It includes
vital (birth and death) information as well as marriages. Specific options:
number of forward generations to consider.

FTM vooroudersverslag This report creates an ancestral report similar to that produced by the Family
Tree Maker (tm) program. It covers in detail the Active Person and his/her
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ancestors It includes vital information as well as marriages, children, and
notes. Specific options: number of backward generations to consider.

FTM afstammelingenverslag This report creates a descendant report similar to that produced by the Fa-
mily Tree Maker (tm) program. It covers in detail the Active Person and his/
her descendants. It includes vital information as well as marriages, children,
and notes. Specific options: number of forward generations to consider.

Family Group Report This creates a family group report, showing information on a set of parents
and their children. Specific options: the spouse (available only if the Active
Person has more than one spouse).

Individuele samenvatting This report produces a detailed summary on the active person. The report
includes all the facts known to the database about that person.

Common options for text reports are the filename of the output, the format of the output, selected style, page size
and orientation. For HTML reports, there is no page information. Instead, HTML options include the choice of
the HTML template, either available in GRAMPS or a custom template defined by you. Optionally, the reports
can be immediately opened with the default application.

Tip

The options used in reports are persistent: each report remembers its options used last time.

3.9.6. Schermverslagen
Schermverslagen zijn algemene samenvattingen van het gegevensbestand die direct op het scherm getoond wor-
den. De volgende schermverslagen zijn momenteel beschikbar in GRAMPS:

Aantal voorouders Dit verslag toont het aantal voorouders van de actieve persoon.

Samenvatting van het gegevensbe-
stand

Dit verslag toont algemene statistieken zoals : aantal individuen per ge-
slacht, verscheidene niet volledige elementen en familie en media statistie-
ken.

3.9.7. Web Pagina
Het enige beschikbare rapport in deze categorie is "Verhalend Web-pagina" rapport. Dit rapport genereert een
web-site (= een aantal gelinkte web-pagina's), voor een aantal personen.

3.9.7.1. Verhalende Web-site

Inleiding GRAMPS 2.0.6 introduceerde de verhalende Web-generator. Het nieuwe
hulpmiddel geeft veel meer functionaliteit dan de oude web-generator.
I.p.v. HTML-sjablonen te gebruiken om de eigen pagina's aan te maken,
worden nu CSS-stijlbladen gebruikt.

More information is now displayed about each person, along with informa-
tion about sources, places, and media objects. Introduction pages can be
added to provide additional information, such as family history.

De uitvoer selecteren Genealogische gegevens kunnen een hele reeks bestanden aanmaken. Ve-
le web-servers heebn problemen wanneer er zich vele bestanden in één
map bevinden. De generator tracht daarom het aantal bestanden per map
te beperken tot een beheersbaar nivo. Om dit mogelijk te maken wordt een
hierarche van mappen aangemaakt. De aangemaakte bestandsnamen zijn
niet intuitief, maar uniek per persoon. Wanneer de web-generator opnieuw
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wordt gelopen zullen identieke besanden worden aangemaakt. Dit maakt
het eenvoudig om bepaalde bestanden te vervangen.

By default, the output files are written to the specified directory. Because
of the number of files and directories that are created, it may be difficult to
transfer the files to an external web host. To aid in this, you may directly
create a gzip'd tar file to more easily upload the data. This is the format
that should be used if you would like to take advantage of the free genea-
logy page hosting at the GRAMPS web hosting site [http://family.gramps-
project.org].

Om een gezipt tar bestand te kiezen, selecteer de optie Web pagina's in
.tar.gz archief opslaan.

Een filter gebruiken Zoals ook voorzien in de vorige web-generator en de meeste andere versla-
gen, kunt u wat in de uitvoer begrepen is, controleren door een filter te ge-
bruiken. Verscheidene standaard filters worden aangeboden, maar het staat
u vrij om een eigen filter aan te maken.

Any person matching this filter who is not excluded due to the privacy rules,
will be included in the output. The default filter includes all people in the
database.

Een stijlblad gebruiken GRAMPS bevat zes veschillende ingebouwde stijlbladen voor uw web-
pagina's. Elk van deze stijlen geeft een unieke "look" aan uw site. Het aan-
gemaakte bestand draagt de naam narrative.css. U kunt dit bestand
naar believen aanpassen indien u uw pagina's verder wilt veranderen.

If you make modifications to your style sheet, you need to be aware the
regenerating the pages with the same output directory will overwrite your
changes to this file. To prevent this from happening, make sure you choose
No style sheet for subsequent runs.

Karakter set encoding Because of GRAMPS internationalization ability, the default character set
for the HTML pages is UTF-8. This provides support for virtually all
characters.

The Apache web server is sometimes misconfigured to override the charac-
ter set specified in an HTML page. This causes problems with the UTF-8
character set generated by GRAMPS, distorting characters on the screen.

If your web server is misconfigured and you do not have priveledge to fix
the configururation, you may solve this problem by overriding the default
character set to match what your web server may be expecting.

Copyright notice International copyright law reserves all rights to your data. You own the
data, and people must get your permission to use it. In genealogy, however,
sharing data is a common ideal. It this case, you may wish to grant the user
more rights.

While the default for GRAMPS is to place a notice indicating that all rights
are reserved, we give you the option to place your site under one of several
of the Create Commons licenses. With a Creative Commons license, you
grant user's certain permission to use your data without requiring them to
contact you directly for permission.

See the Creative Commons [http://creativecommons.org/] web site for mo-
re information.

Controlling page generation Three additional pages can be generated by the web page generator. The
Home page is a page that will display an image and a whatever text you

http://family.gramps-project.org
http://creativecommons.org/
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wish. To enable this page, choose a Media Object from the Home Media/
Note ID menu on the Page Generation tab. If the Media Object contains an
image, the image is displayed at the top of the page. If the Media Object
contains a Note, the Note's text is used for the text of the page. A second
page, the Introduction page, works similarly. Just choose the Media Object
in the Introduction Media/Note ID menu.

If you choose to include a contact page, the researcher information stored
in the database is displayed, along with the information specified in the
Publisher contact/Note ID menu. Please use this page with caution, since
you may consider your contact information to be private.

Privacy Privacy of personal information is an important issue on the web today.
GRAMPS tries to give you control over the information that is presented.

GRAMPS provides two options to control the privacy of your information.
If you select the Do not include records marked private option, any data
that is marked as private will not be displayed on the generated site. If you
select Restrict information on living people, GRAMPS will attempt to de-
termine which people have the potential of still being alive, and will omit
these people from the database. Some countries have laws that indicate that
a certain number of years must pass after someone's death before informa-
tion can be published. The Years to restrict from person's death option al-
lows you to specifiy how many years a person must be deceased before the
information is included.

Please note that it is your responsibility to double check all information in
the pages for any privacy information. GRAMPS cannot be held responsi-
ble for any privacy issues.

Adding custom code your pages If you are not interested in customizing your pages, you may skip the sec-
tion.

The previous web generator allowed you to customize your pages using
HTML templates. Your data would be substituted for certain markers in
the code.

This method proved to be too cumbersome for most users. The Narrative
Web Page Generator introduces a simpler mechanism. On the Page Gene-
ration tab, you may specify text (including HTML code) that will be inser-
ted into each page, separately for the header and the footer.

To create this code, you need to create a Media Object marked as an internal
note. To create this, add a new Media Object in the Media View, and select
the internal note option. You may then enter your HTML code.

To insert the code from the internal notes into the web pages, select the
appropriate Media Objects from the HTML user header and HTML user
footer menus. Two div sections will be added to the pages - userheader and
userfooter. The corresponding HTML code is inserted into the HTML page
surrounded by div markers. You can customize your style sheet to provide
additional formatting and positioning information to control these sections.

3.10. Running Tools
GRAMPS tools allow you to perform various types of analysis of your genealogical data. Typically, the tools do
not produce output in form of printouts or files. Instead, they produce screen output immediately available for the
researcher. However, when appropriate, you can save the results of running a tool into a file. Tools present one of
the major strengths of GRAMPS compared to the most genealogical software.
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The tools can be accessed through the menu by choosing Tools->Tool Section->Particular Tool.
Alternatively, you can browse the complete selection of available tools along with their brief descriptions in a
Tool Selection dialog invoked by clicking the Tools icon on the toolbar.

3.10.1. Analyse en onderzoek
This section contains tools which analyze and explore the database, but do not alter it. The following analysis and
exploration tools are currently available in GRAMPS:

Individuele gebeurtenissen vergelij-
ken

This tool compares events across the selected group of people. The people
for this comparison are chosen with the use of custom filters. The custom
filters can be created in the Custom Filter Editor (see Paragraaf 3.10.3.1,
“Eigen filters aanpassen”) that can be invoked by clicking the Custom Filter
Editor button. The resulting table produced by this tool can be saved as a
spreadsheet.

Interactive descendant browser This tool builds a tree with the Active Person being the root. Children
branch from their parents in the usual manner. Use this tool for a quick
glance of a person's descendants.

Tip

Double-clicking on tree node will bring up the Edit Person
dialog allowing to view or modify the personal data.

3.10.2. Gegevensbestand wordt verwerkt
This section contains tools which may modify your database. The tools from this section are used mostly for finding
and correcting errors in the data. The following database processing tools are currently available in GRAMPS:

Opmerking

The modifications will only be performed upon your explicit consent, except for the automatic fixes
performed by Check and repair database tool.

Controleren en herstellen gege-
vensbestand

This tool checks the database for integrity problems, fixing the problems it
can. Specifically, the tool is checking for:

• Broken family links. These are the cases when a person's record refers
to a family while the family's record does not refer to that person, and
vice versa.

• Missing media objects. The missing media object is the object whose
file is referenced in the database but does not exist. This can happen
when the file is accidentally deleted, renamed, or moved to another lo-
cation.

• Lege Families. Dit zijn familie gegevens die geen enkele referentie heb-
ben naar iemand.

• Parent relationship. This checks all families to ensure that father and
mother are not mixed up. The check is also made that parents have dif-
ferent gender. If they have common gender then their relationship is
renamed to "Partners".

Informatie uit namen halen This tool searches the entire database and attempts to extract titles and nick-
names that may be embedded in a person's Given name field. If any infor-
mation could be extracted, the candidates for fixing will be presented in the
table. You may then decide which to repair as suggested and which not to.
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Vind mogelijke persoonsduplikaten Dit hulpmiddel doorzoekt het volledige gegevensbestand en kijkt naar ge-
gevens die mogelijk eenzelfde persoon voorstellen.

Fix capitalization of family names This tool searches the entire database and attempts to fix the capitalization
of family names. The aim is to have conventional capitalization: capital first
letter and lower case for the rest of the family name. If deviations from this
rule are detected, the candidates for fixing will be presented in the table.
You may then decide which to repair as suggested and which not to.

Rename personal event types This tool allows all the events of a certain name to be renamed to a new
name.

GRAMPS ID's herschikken This tool reorders the GRAMPS IDs according to the defaults of GRAMPS.

3.10.3. Utilities
This section contains tools allowing you to perform a simple operation on a portion of data. The results can be
saved in your database, but they will not modify your existing data. The following utilities are currently available
in GRAMPS:

3.10.3.1. Eigen filters aanpassen

The Custom Filter Editor builds custom filters that can be used to select people included in reports, exports, and
other tools and utilities. This is in fact a very powerful tool in genealogical analysis.

When you launch it, the User defined filters dialog appears that lists all the filters (if any) previously defined by
you. Click the Add... button to define a new filter. Once you have designed your filters, you can edit, test, and
delete selected filters using the Edit..., Test..., and Delete buttons, respectively. All the filters displayed in the list
will be automatically saved along with your database and will be available with subsequent sessions of GRAMPS.

Opmerking

The changes made to the filters only take effect when you click the Apply and close button.

Clicking the Add... button invokes the following Define filter dialog:

Figuur 3.35. Dialoog filter opstellen
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Type the name for your new filter into the Name field. Enter any comment that would help you identify this filter
in the future into the Comment field. Add as many rules to the Rule list as you would like to your filter using
Add... button. If the filter has more than one rule, select one of the Rule operations. This allows you to choose
whether all rules must apply, only one (either) rule must apply, or exactly one (either) rule must apply, in order
for the filter to generate a match. If your filter has only one rule, this selection has no effect.

Check Return values that do not match the filter rules to invert the filter rule. For example, inverting "has a common
ancestor with I1" rule will match everyone who does not have a common ancestor with that person).

Klikken op de Toevoegen... knop toont de volgende Regel toevoegen dialoog:

Figuur 3.36. Dialoog regel toevoegen

The pane on the left-hand side displays available filter rules arranged by their categories in an expandable tree.
For detailed filter rule reference, see Bijlage C, Filter rules reference. Click on the arrows to fold/unfold the
appropriate category. Select the rule from the tree by clicking on its name. The right-hand side displays the name,
the description, and the values for the currently selected rule. Once you are satisfied with your rule selection and
its values, click OK to add this rule to the rule list of the currently edited filter. Clicking Cancel will abort adding
the rule to the filter.

Tip

A filter you have already designed may be used as a rule for another filter. This gives you nearly
infinite flexibility in custom-tailoring your selection criteria that can be later used in most of the
exports, reports, and some of the tools (such as comparing individual events).

3.10.3.2. Kladblok

This tool provides a temporary note pad to store database records for easy reuse. In short, this is a sort of the
copy-and-paste functionality extended from textual objects to other types of records used in GRAMPS.

Tip

Scratch Pad makes extensive use of drag-and-drop technique.

To invoke Scratch Pad, either choose Tools->Utilities->Scratch Pad or click the ScratchPad button on the toolbar.
The following window will appear:
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Figuur 3.37. Kladblokgereedschap

Scratch Pad supports addresses, attributes (both personal and family), events (both personal and family), names,
media objects references, source references, URLs, and of course textual information of notes and comments. To
store any type of these records, simply drag the existing record on to the Scratch Pad from the corresponding
editor dialog. To reuse the record, drag it from the Scratch Pad on to the corresponding place in the editor, e.g.
Address tab, Attribute tab, etc.

Tip

Some objects are showing the link icon on the left. This indicates that dragging such selection will
produce a reference to an existing object, not copy the object itself.

For example, the media object file will not be duplicated. Instead, the reference will be made to an
existing media object, which will result in the local gallery entry.

Tip

Scratch Pad storage is persistent within a single GRAMPS session. Closing the window will not lose
the stored records. However, exiting GRAMPS will.

3.10.3.3. Andere hulpmiddelen

Genereer SoundEx codes This utility generates SoundEx codes for the names of pe-
ople in the database. Please visit the NARA Soundex In-
dexing page [http://www.archives.gov/research_room/genealogy/census/
soundex.html] to learn more about Soundex Indexing System.

Berekenen van relaties This utility calculates and displays the relationship of any person to the
Active Person.

Het gegevensbestand nakijken Dit hulpgereedschap laat u toe om het gegevensbestand te controleren op
basis van een aantal criteria door u opgegeven.

Het verschil tussen het
Controlegereedschap en het zojuist
beschreven gereedschap

Het controlegereedschap zal onvolmaaktheden in het gege-
vensbestand opsporen. Nakijken van het gegevensbestand zal
die gegevens zoeken die niet voldoen aan de door u opgege-
ven criteria.

Bijvoorbeeld, u wilt zeker stellen dat niemand in het gegevensbestand kin-
deren krijgt op 98-jarige leeftijd. Gebaseerd op gezond verstand zou zo een

http://www.archives.gov/research_room/genealogy/census/soundex.html
http://www.archives.gov/research_room/genealogy/census/soundex.html
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gegeven duidelijk een fout bevatten. Maar het is geen onvolmaaktheid in
de struktuur van het gegevensbestand. Het gereedschap "nakijken" zal alles
tonen dat in tegenspraak is met de criteria zodat u kunt controleren of de
gegevens fout zijn of niet. De uiteindelijke beslissing ligt bij u.
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Hoofdstuk 4. Instellingen
4.1. Voorkeuren
De meeste instellingen in GRAMPS, worden vastgelegd met de Voorkeuren dialoog. Om deze dialoog op te
roepen: kies Aanpassen->Voorkeuren....

Figuur 4.1. Voorkeurendialoog

De tabbladen bovenaan het bovenste venster tonen de beschikbare opties.

4.1.1. Algemeen
Deze categorie bevat voorkeuren die van toepassing zijn op het volledige programma. Opties zijn:

Laad automatisch het laatste gege-
vensbestand

Klik aan om automatisch het laatst geopende gegevensbestand opnieuw te
openen bij opstart.

Voeg standaard bron toe bij impor-
teren

Deze optie beïnvloedt het importeren van gegevens. Wanneer dit actief
staat, zal elke geïmporteerd item, een bronreferentie bevatten naar het ge-
ïmporteerd bestand.

Opmerking

Het toevoegen van een standaard bron kan de tijd nodig om
de gegevens te importeren gevoelig verhogen.

Activeert de spellingscontrole Deze optie controleert of de spellingscontrole van de opmerkingen, al of
niet actief is. Het pakket "gtkspell" moet wel eerst geladen zijn voor de
spellingscontrole kan werken.

Toon tip van de dag Deze optie stuurt het al of niet tonen van de dagtip bij het opstarten.

Gebruik van schaduwen bij het re-
latiescherm

Deze optie regelt of er al of niet een schaduw getoont wordt in het relatie-
scherm. Indien actief, zal informatie gegroepeerd worden in gebieden met
een schaduwachtergrond.
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Laat gegevensbestandtransacties
toe

Deze optie stuurt het al of niet toelaten van transacties gedurende gegevens-
bestandoperaties.

Waarschuwing

Let op bij het kiezen van deze optie. Standaard worden trans-
acties toegelaten. Dit verbeterd de snelheid van uitvoeren en
beveiligd de integriteit van het gegevensbestand. Indien uw
systeem een lagere versie dan 2.5 van de Python-taal ge-
bruikt, zal uw gegevensbestand niet overzetbaar zijn naar an-
dere computers. Indien u dit toch wenst te doen, exporteer dan
naar het GRAMPS XML-formaat. Uitzetten van deze optie
laat toe dat uw gegevensbestand overzetbaar is, maar er blijft
een integriteitsrisico.

4.1.2. Beeld
Deze categorie bevat de voorkeuren ivm. het tonen van gegevens. Opties zijn:

Datumformaat Deze optie bepaalt hoe datum getoond worden. Verscheidene verschillende
formaten zijn beschikbaar die mogelijk afhangen van de locale taalinstel-
lingen.

Voorstellen voor de achternaam Deze optie bepaalt de initiele familienaam van een kind wanneer dat wordt
toegevoegd aan het gegevensbestand.

Tip

This option only affects the initial family name guessed by
GRAMPS when the Edit Person dialog is launched. You can
modify that name the way you see fit. Set this option to the
value that you will most frequently use, as it will save you a
lot of typing.

If None is selected, no guessing will be attempted. Selecting Father's sur-
name will use the family name of the father. Selecting Combination of
mother's and father's surname will use the father's name followed by the
mother's name. Finally, Icelandic style will use the father's given name fol-
lowed by the "sson" suffix (e.g. the son of Edwin will be guessed as Ed-
winsson).

Statusbalk Deze optie bepaald welke informatie getoond wordt in de statusbalk. Dit
kan zijn, ofwel de naam van de actieve persoon en de GRAMPS ID of de
relatie van de actieve persoon tot de basispersoon.

Toont tekst in de zijbalkknoppen Deze optie controleert of er al dan niet tekst getoond wordt naast de iconen
in de zijbalk. Deze optie werkt enkel na herstarten van het programm.

4.1.3. Tonen van namen
This category contains preferences relevant to the display of names. In GRAMPS there are two type of name
display formats: the predefined formats, and the user defined custom formats. The predefined formats are:

• Family name, Given name Patronymic

• Given name Family name

• Patronymic, Given name

• Given name



4.1.4. ID-formaten

73

When predefined formats are not suitable one can define it's own format.

Display format The system wide name format is selected here from a list, which contains both
the predefined and custom name formats (if any).

Opmerking

Besides the system wide setting GRAMPS allows deciding the na-
me display format individually for every single name via the Na-
me Editor dialog (see Paragraaf 3.7.9, “Namen”).

Custom format details It expands the custom format handling user interface.

Opmerking

Custom name display formats are stored in the databases, thus be-
fore loading any database the Custom format details expander is
disabled.

Add Opens the Name Format Editor window to define a new custom for-
mat.

Remove Deletes the selected custom Name Display format.

Edit Opens the Name Format Editor window to modify the selected cus-
tom Name Display format.

4.1.3.1. Name Format Editor

New formats are created, and existing formats are modified using this editor.

Format name The name of the custom format. The format name can be any string, it is
used only to recognize the format later on the Display format list.

Format definition The actual format is defined here using special formatting characters. Befo-
re and after these special characters any other character or string is allowed.
For exmple:  "(%t) %L, %f" will give "(Dr.) SMITH, Edwin".
The formatting characters are:

Character Name Character Name

%f Given Name %F GIVEN NAME

%l Surname %L SURNAME

%t Title %T TITLE

%p Prefix %P PREFIX

%s Suffix %S SUFFIX

%c Call name %C CALL NAME

%y Patronymic %Y PATRONYMIC

Example Shows a dynamic example how the name will be displayed with the current
Format definition string.

Format definition details Shows a quick reminder of the special formatting characters.

4.1.4. ID-formaten
Deze categorie bevat de voorkeuren ivm. de automatische aanmaak van GRAMPS ID's.
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Tip

De ID-voorvoegsels gebruiken de formaatconventies die gebruikelijk zijn in C, Python en andere
programmeertalen. Bijvoorbeeld, het formaat %04d bepaald dat dit cijfer een geheel getal is met een
totale lengte van 4 cijfers, eventueel opgevuld met nullen vooraan. Indien u de ID's in de vorm wilt
hebben :1, 2, 3..., zet u de formaatoptie op %d.

Persoon Dit sjabloon bepaalt hoe persoon-ID's worden aangemaakt.

Familie Dit sjabloon bepaalt hoe familie-ID's worden aangemaakt.

Locatie Dit sjabloon bepaalt hoe locatie-ID's worden aangemaakt.

Bron Dit sjabloon bepaalt hoe bron-ID's worden aangemaakt.

Media Object Dit sjabloon bepaalt hoe media-objecten-ID's worden aangemaakt.

Gebeurtenis Dit sjabloon bepaalt hoe gebeurtenissen-ID's worden aangemaakt.

Bibliotheek Dit sjabloon bepaalt hoe bibliotheek-ID's worden aangemaakt.

4.1.5. Waarschuwingen
Deze dialoog controleert hoe waarschuwingsdialogen worden getoond. Hiermee kunt u bepaalde uitgeschakelde
dialogen opnieuw instellen.

4.1.6. Onderzoekerinformatie
Enter your personal information in the corresponding text entry fields. Although GRAMPS requests information
about you, this information is used only so that GRAMPS can create valid GEDCOM output files. A valid GE-
DCOM file requires information about the file's creator. If you choose, you may leave the information empty,
however none of your exported GEDCOM files will be valid.

4.1.7. Markeerkleuren
This category controls the highlight color of items in the Person list when a marker has been set for a person.

4.2. Andere instellingen
Besides Preferences dialog, there are other settings available in GRAMPS. For various reasons they have been
made more readily accessible, as listed below.

Aanpassen van kolommen The columns of the list views may be added, removed, or reordered in a
Column Editor Dialog, see Figuur 2.4, “Dialoog aanpassen kolommen”.
Only checked columns will be shown in the view. To change their order,
drag any column to its desired place inside the editor. Clicking OK will re-
flect the changes in the appropriate view. To invoke Column Editor Dialog,
choose Edit->Column Editor....

Tip

The Column Editor is available and works in the same way
for all list views. Specifically, it is available for People View,
Family View (children list). Sources View, Places View, and
Media View.

Bepalen van de basispersoon The Home person is the person who becomes active when database opened,
when Home button is clicked or the Home menu item is selected from either
Go menu or the right-click context menu anywhere.
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To set Home person, make the desired person active and then choose Edit-
>Set Home person....

Adjusting viewing controls Whether the toolbar, the sidebar, or the filter (People View only) are dis-
played in the main window is adjusted through the View menu.

4.3. Advanced manipulation of settings
Waarschuwing

The contents of this section is outside the scope of interest of a general user of GRAMPS. If you
proceed with tweaking the options on the low level you may damage your GRAMPS installation.
Be careful. YOU HAVE BEEN WARNED!

By default, GRAMPS stores its settings using gconf2 system. All the settings used in this version of GRAMPS
are stored in subdirectories under /apps/gramps/ in the gconf2 namespace. Accessing the keys can be done
either using gconftool-2 command line tool, or the gconf-editor GUI tool.

All keys are documented, and the notification mechanisms are used as appropriate. Therefore, updating keys from
outside of GRAMPS should lead to updating GRAMPS in real time, without necessarily restarting it.
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Bijlage A. FAQ : vaak gestelde vragen
This appendix contains the list of questions that frequently come up in mailing list discussions and forums. This
list is by no means complete. If you would like to add questions/answers to this list, please email your suggestions
to gramps-devel@lists.sf.net [mailto:gramps-devel@lists.sf.net]

Wat is GRAMPS? GRAMPS staat voor "Genealogical Research and Analysis Management
Program System" dus een genealogisch onderzoeks- en analyse beheersys-
teem. Met andere woorden het is een volledig persoonlijk genealogisch pro-
gramma dat u toelaat, om met behulp van een computer, al uw genealogi-
sche gegevens op te slaan, te bewerken en te onderzoeken.

Waar haal ik het vandaan en hoe-
veel kost het?

GRAMPS kan volledig gratis opgeladen worden van deze link http://sf.net/
projects/gramps. GRAMPS is een open bronprgramma onder de GNU "Ge-
neral Public License". U hebt volledige toegang tot de broncode en u kunt
vrijelijk het programma en de broncode verdelen.

Werkt het met Windows (tm)? Nee. GRAMPS maakt gebruik van de GTK en GNOME-bibliotheken. De
GTK-bibliotheken zijn overdraagbaar naar Windows; voor de GNOME-bi-
bliotheken is dit nog niet het geval. Dit kan natuurlijk in de toekomst ver-
anderen.

Werkt het op een Mac ? The Fink project [http://fink.sourceforge.net] has ported  some older versi-
ons [http://fink.sourceforge.net/pdb/package.php/gramps] of GRAMPS to
OSX (tm). The Mac OSX port is not directly supported by the GRAMPS
project, primarily because none of the GRAMPS developers have access to
Mac OSX and because OSX is not Free Software.

Deze GRAMPS-versie (2.2.0) is blijkbaar niet omzetbaar door het Fink-
project. Contacteer daarom het Fink-project voor verdere informatie.

Sommigen hadden succes door gebruik te maken van de "DarwinPorts" ipv.
het Fink-project.

Werkt het met KDE? Ja, althans indien de juiste GNOME bibliotheken zijn geïnstalleerd.

Moet GNOME werkelijk geïnstal-
leerd zijn?

Ja, maar het GNOME bureaublad hoeft niet gestart te zijn.

Welke GNOME-versie heb ik no-
dig?

Deze versie van GRAMPS vereist GNOME v2.8.0 of hoger. De vorige ver-
sies van de 1.0.x serie vereisen GNOME 2.0.

IS GRAMPS verenigbaar met an-
dere genealogische programma's?

GRAMPS makes every effort to maintain compatibility with GEDCOM,
the general standard of recording genealogical information. We have import
and export filters that enable GRAMPS to read and write GEDCOM files.

It is important to understand that the GEDCOM standard is poorly imple-
mented -- virtually every genealogical software has its own "flavor" of GE-
DCOM. As we learn about new flavor, the import/export filters can be cre-
ated very quickly. However, finding out about the unknown flavors requi-
res user feedback. Please feel free to inform us about any GEDCOM flavor
not supported by GRAMPS, and we will do our best to support it!

Kan GRAMPS bestanden aange-
maakt door andere genealogische
programma's, lezen?

Zie boven.

Can GRAMPS write files readable
by other genealogy programs?

Zie boven.

mailto:gramps-devel@lists.sf.net
http://sf.net/projects/gramps
http://sf.net/projects/gramps
http://fink.sourceforge.net
http://fink.sourceforge.net/pdb/package.php/gramps
http://fink.sourceforge.net/pdb/package.php/gramps
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Kan GRAMPS een stamboom van
mijn familie uitdrukken?

Yes. Different people have different ideas of what a genealogical tree is.
Some think of it as a chart going from the distant ancestor and listing all
his/her descendants and their families. Others think it should be a chart
going from the person back in time, listing the ancestors and their families.
Yet other people think of a table, text report, etc.

GRAMPS can produce any of the above, and many more different charts
and reports. Moreover, the plugin architecture enables users (you) to create
their own plugins which could be new reports, charts, or research tools.

In welk formaat geeft GRAMPS
uitvoerverslagen weer?

Tekstverslagen zijn beschikbaar in HTML, PDF, AbiWord, KWord, La-
TeX, RTF, and OpenOffice formaten. Grafische verslagen (diagrammen
enz) zijn beschikbaar in PostScript, PDF, SVG, OpenOffice, and GraphViz
formaten.

Is GRAMPS compatibel met het
Internet?

GRAMPS can store web addresses and direct your browser to them. It can
import data that you download from the Internet. It can export data that
you could send over the Internet. GRAMPS is familiar with the standard
file formats widely used on the Internet (e.g. JPEG, PNG, and GIF images,
MP3, OGG, and WAV sound files, QuickTime, MPEG, and AVI movie
files, etc). Other than that, there is little that a genealogical program can do
with the Internet.

Kan ik eigen verslagen/filters/
enz.aanmaken?

Yes. There are many levels of customization. One is creating or modifying
the templates used for the reports. This gives you some control over the
fonts, colors, and some layout of the reports. You can also use GRAMPS
controls in the report dialogs to tell what contents should be used for a par-
ticular report. In addition to this, you have an ability to create your own
filters -- this is useful in selecting people based on criteria set by you. You
can combine these filters to create new, more complex filters. Finally, you
have an option to create your own plugins. These may be new reports, re-
search tools, import/export filters, etc. This assumes some knowledge of
programming in Python.

Welke standaarden ondersteunt
GRAMPS?

The nice thing about standards is that there never is a shortage of them.
GRAMPS is tested to support the following flavors of GEDCOM: GED-
COM5.5, Brother's Keeper, Family Origins, Family Tree Maker, Ftree, Ge-
neWeb, Legacy, Personal Ancestral File, Pro-Gen, Reunion, and Visual Ge-
nealogie.

Wat is de maximale grootte van
het gegevensbestand dat GRAMPS
aankan (in bytes)?

GRAMPS has no hard limits on the size of a database that it can handle.
Starting with this release, GRAMPS no longer loads all data into memory,
which allows it to work with a much larger database than before. In reality,
however, there are practical limits. The main limiting factors are the avai-
lable memory on the system and the cache size used for BSDDB database
access. With common memory sizes these days, GRAMPS should have no
problem using databases with tens of thousands of people.

Hoeveel personen kan het
GRAMPS-gegevensbestand aan?

We ervaarden dat op een typisch systeem een belangrijke tijdsvertraging te
merken was indien het gegevensbestand rond de 150.000 personen bevat.
Natuurlijk is dit ook afhankelijk van de heoveelheid systeemgeheugen.

Waarom loopt GRAMPS zo traag? Nu niet meer! Gebruik de juiste 2.2.0 versie.

Mijn gegevensbestand is zeer
groot. Is er een mogelijkheid om te
vermijden dat al deze gegevens in
het geheugen geladen moeten wor-
den?

Beginnende vanaf deze versie van GRAMPS, worden niet alle gegevens in
het geheugen geladen. Dit laat toe om met een veel groter gegevensbestand
te kunnen werken dan voorheen het geval was.
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Ik wil de opstartdialoog opnieuw
zien. Hoe doe ik dat?

GRAMPS keeps a flag in the GNOME configuration database to indicate
that the startup dialog has been run. To cause GRAMPS to rerun this, the
flag needs to be reset. This can be done with the following command:

gconftool-2 -u /apps/gramps/behavior/startup

Waarom worden niet-latijnse ka-
rakters as rommel getoond in PDF/
PS verslagen?

Dit is een beperking van de ingebouwde lettertekens van het PS en PDF-
formaat. Om niet-latijnse tekst uit te drukken gebruikt u Drukken... in het
formaatselectie menu van de verslagdialoog. Op deze wijze wordt de gno-
me-backend gebruikt, die het aanmaken van PS en PDF ondersteund even-
als gewone drukopdrachten.

Indien u enkel latijnse tekst hebt, zal de PDF-optie een kleiner fomaat le-
veren vergeleken met "gnome-print" omdat geen karakterinformatie mee-
genomen wordt.

Why can I not add/remove/edit co-
lumns to the lists in People View
and Family View?

Now you can! Just try out the current version, 2.2.0.

I would like to contribute to
GRAMPS by writing my favorite
report. How do I do that?

The easiest way to contribute to reports, filters, tools, etc. is to copy
an existing GRAMPS report, filter, or tool. If you can create what you
want by modifying existing code -- great! If your idea does not fit in-
to the logic of any existing GRAMPS tool, the following page [http:/
/gramps.sourceforge.net/phpwiki/index.php/GrampsDevelopersPage] may
provide some help in writing your own plugin from scratch.

If you need more help or would like to discuss your idea with us, please
do not hesitate to contact us at gramps-devel@lists.sf.net [mailto:gramps-
devel@lists.sf.net]

To test your work in progress, you may save your plugin under $HOME/
.gramps/plugins directory and it should be found and imported on
startup. The correctly written plugin will register itself with GRAMPS, cre-
ate menu item, and so on.

If you are happy with your plugin and would like to contribute your code
back to the GRAMPS project, you are very welcome to do so by contacting
us at gramps-devel@lists.sf.net [mailto:gramps-devel@lists.sf.net]

I found a bug and I want it fixed
right now! What do I do?

The best thing you can do is to fix the bug and send the patch to gramps-
devel@lists.sf.net [mailto:gramps-devel@lists.sf.net] :-)

A good bug report would include:

• Version of gramps you were using when you encountered the bug (avai-
lable through Help->About menu item).

• Taal waaronder GRAMPS liep (voer

echo $LANG uit

in een terminal).

• Symptoms indicating that this is indeed a bug.

• Any Traceback messages, error messages, warnings, etc, that showed
up in your terminal or a in separate traceback window.

Most problems can be fixed quickly provided there is enough information.
To ensure this, please follow up on your bug reports. In particular, if you

http://gramps.sourceforge.net/phpwiki/index.php/GrampsDevelopersPage
mailto:gramps-devel@lists.sf.net
mailto:gramps-devel@lists.sf.net
mailto:gramps-devel@lists.sf.net
mailto:gramps-devel@lists.sf.net
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file a bug report with sf.net bug tracker, PLEASE log in to sf.net before
filing (register your free account if you don't have one). Then we will have
a way of contacting you should we need more information. If you choose
to file your report anonymously, at least check every so often whether your
report page has something new posted, as it probably would.

If the above explanations seem vague, please follow this link. [http://
www.chiark.greenend.org.uk/~sgtatham/bugs.html]

It is obvious that GRAMPS abso-
lutely needs to become a (client-
server/web-based/PHP/weblog/Ja-
vascript/C++/distributed/KDE/Mo-
tif/Tcl/Win32/C#/You-name-it)
application. When is this going to
happen?

The surest way to see it happen is to get it done by yourself. Since GRAMPS
is free/open source, nobody prevents you from taking all of the code and
continuing its development in whatever direction you see fit. In doing so,
you may consider giving your new project another name to avoid confu-
sion with the continuing GRAMPS development. If you would like the
GRAMPS project to provide advice, expertise, filters, etc., we will gladly
cooperate with your new project, to ensure compatibility or import/export
options to your new format of a project.

If, however, you would like the GRAMPS project to adopt your strategy,
you would need to convince GRAMPS developers that your strategy is good
for GRAMPS and superior to the present development strategy.

http://www.chiark.greenend.org.uk/~sgtatham/bugs.html
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Bijlage B. Sneltoetsreferentie
Most of the standard menu items define equivalent keybindings. These are apparent because they are displayed
on the right of the menu item. However, some keybindings are not associated with any items in the menu.

Deze appendix bevat een lijst van alle sneltoetsen die niet getoond worden in de vezrschillende menu's van
GRAMPS.

B.1. Schermen met lijsten

B.1.1. Common bindings
De volgende sneltoetsen zijn beschikbaar in alle schermen met lijsten: personenscherm, bronnenscherm, locatie-
scherm en mediascherm.

Toets Functie

<Alt>N Changes the view to the next view

<Alt>P Changes the view to the previous view

<Alt>S Open the Scratch Pad

<Ctrl>B Edit the bookmarks

<Ctrl>D Add the selected item as a bookmark

<Ctrl>H Open the Undo History dialog

B.1.2. People View bindings

Toets Functie

<Ctrl>Enter Edits the selected person

<Ctrl>Insert Adds a new person to the database

<Ctrl>Delete Deletes the selected person



82



83

Bijlage C. Filter rules reference
This appendix lists of all the filter rules currently defined in GRAMPS. Each of these rules is available for use when
creating custom filters, see Paragraaf 3.10.3.1, “Eigen filters aanpassen”. The rules are listed by their categories.

C.1. Algemene filters
This category includes the following most general rules:

Has complete record This rule matches all people whose records are marked as complete. Cur-
rently, the completeness of personal information is marked manually, in the
Edit Person dialog.

Personen met onvolledige namen This rule matches all people with either given name or family name missing.

Is bookmarked person This rule matches all people who are on the bookmark list.

Has text matching substring of This rule matches all people whose records contain specified substring. All
textual records are searched. Optionally, the search can be made case sen-
sitive, or a regular expression match.

Iedereen This rule matches any person in the database. As such it is not very useful
on its own except for testing purposes. However, it may be useful in com-
binations with other rules.

Personen die waarschijnlijk nog in
leven zijn

This rule matches all people whose records do not indicate their death and
who are not unreasonably old, judging by their available birth data and
today's date.

Heeft als naam This rule matches any person whose name matches the specified value in
full or in part. For example, Marta Ericsdotter will be matched by the rule
using the value "eric" for the family name.

Separate values can be used for Given name, Family name, Suffix, and the
Title. The rule returns a match if, and only if, all non-empty values are
(partially) matched by a person's name. To use just one value, leave the
other values empty.

Heeft als ID This rule matches any person with a specified GRAMPS ID. The rule re-
turns a match only if the ID is matched exactly.

You can either enter the ID into a text entry field, or select a person from
the list by clicking Select... button. In the latter case, the ID will appear in
the text field after the selection was made.

Is de standaardpersoon Deze regel komt overeen met de standaard (basis) persoon.

Mensen gemerkt als privaat Deze regel vindt personen met private gegevens.

Is vrouwelijk Deze regel vindt alle vrouwelijke personen.

Personen die beelden hebben This rule matches people with images in their galleries.

Personen met een geboortedatum Deze regel vindt personen zonder geboortedatum.

Is mannelijk Deze regel vind alle mannelijke personen.

C.2. Gebeurtenisfilters
This category includes the following rules that match people based on their recorded events:
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Has the birth This rule matches people whose birth event matches specified values for
Date, Place, and Description. The rule returns a match even if the person's
birth event matches the value partially. The matching rules are case-insen-
sitive. For example, anyone born in Sweden will be matched by the rule
using the value "sw" for the Place.

The rule returns a match if, and only if, all non-empty values are (partially)
matched by a person's birth. To use just one value, leave the other values
empty.

Has the death This rule matches people whose death event matches specified values for
Date, Place, and Description. The rule returns a match even if the person's
death event matches the value partially. The matching rules are case-insen-
sitive. For example, anyone who died in Sweden will be matched by the
rule using the value "sw" for the Place.

The rule returns a match if, and only if, all non-empty values are (partially)
matched by a person's death. To use just one value, leave the other values
empty.

Heeft als bron This rule matches people whose records refer to the specified source.

Has the personal event This rule matches people that have a personal event matching specified
values for the Event type, Date, Place, and Description. The rule returns a
match even if the person's event matches the value partially. The matching
rules are case-insensitive. For example, anyone who graduated in Sweden
will be matched by the rule using the Graduation event and the value "sw"
for the Place.

The personal events should be selected from a pull-down menu. The rule
returns a match if, and only if, all non-empty values are (partially) matched
by the personal event. To use just one value, leave the other values empty.

Has the family event This rule matches people that have a family event matching specified values
for the Event type, Date, Place, and Description. The rule returns a match
even if the person's event matches the value partially. The matching rules
are case-insensitive. For example, anyone who was married in Sweden will
be matched by the rule using the Marriage event and the value "sw" for the
Place.

The family events should be selected from a pull-down menu. The rule
returns a match if, and only if, all non-empty values are (partially) matched
by the personal event. To use just one value, leave the other values empty.

Getuige Deze regel vindt alle mensen die als getuige aanwezig waren bij een ge-
beurtenis. Als bovendien 'persoonlijk' of 'familie' als gebeurtenistype opge-
geven wordt, zullen enkel die gebeurtenissen gezocht worden.

Mensen met onvolledige gebeurte-
nissen

Deze regel vindt mensen waar geen datum of locatie in een persoonlijke
gebeurtenis is opgegeven.

Families met onvolledige gebeurte-
nissen

Deze regel vindt mensen met ontbrekende datum of locatie in een familie-
gebeurtenis, in gelijk welk van hun families.

C.3. Familie filters
This category includes the following rules that match people based on their family relationships:

Mensen met kinderen Deze regel vindt alle mensen met kinderen.
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Mensen met meerdere huwelijksge-
gevens

Deze regel vindt personen met méér dan één echtgeno(o)t(e).

Mensen zonder huwelijksgegevens Deze regel vindt alle mensen zonder echtgeno(o)t(e).

Mensen die geadopteerd werden Deze regel vindt alle geadopteerde mensen.

Has the relationships This rule matches people with a particular relationship. The relationship
must match the type selected from the menu. Optionally, the number of
relationships and the number of children can be specified.

The rule returns a match if, and only if, all non-empty values are (partially)
matched by a person's relationship. To use just one value, leave the other
values empty.

Is een echtgeno(o)t(e) van diegene
die de filter vond

This rule matches people married to someone who is matched by the spe-
cified filter. The specified filter name should be selected from the menu.

Is een kind van diegene die de filter
vond

This rule matches people for whom either parent is matched by the specified
filter. The specified filter name should be selected from the menu.

Is een ouder van diegene die de fil-
ter vond

This rule matches people whose child is matched by the specified filter. The
specified filter name should be selected from the menu.

Is een broer of zus van diegene die
de filter vond

This rule matches people whose sibling is matched by the specified filter.
The specified filter name should be selected from the menu.

C.4. Voorouderfilters
This category includes the following rules that match people based on their ancestral relations to other people:

Is een voorouder van This rule matches people who are ancestors of the specified person. The
Inclusive option determines whether the specified person should be consi-
dered his/her own ancestor (useful for building reports).

You can either enter the ID into a text entry field, or select a person from
the list by clicking Select... button. In the latter case, the ID will appear in
the text field after the selection was made.

Is an ancestor of person at least N
generations away

This rule matches people who are ancestors of the specified person and are
at least N generations away from that person in their lineage. For example,
using this rule with the value of 2 for the number of generations will match
grandparents, great-grandparents, etc., but not the parents of the specified
person.

Is an ancestor of person not more
than N generations away

This rule matches people who are ancestors of the specified person and are
no more than N generations away from that person in their lineage. For
example, using this rule with the value of 2 for the number of generations
will match parents and grandparents, but not great-grandparents, etc., of the
specified person.

Heeft een gemeenschappelijke
voorouder met

This rule matches people who have common ancestors with the specified
person.

Heeft een gemeenschappelijke
voorouder met diegene die de filter
vond

This rule matches people who have common ancestors with someone who is
matched by the specified filter. The specified filter name should be selected
from the menu.

Is an ancestor of filter match This rule matches people who are ancestors of someone who is matched
by the specified filter. The specified filter name should be selected from
the menu.
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C.5. Afstammelingen filters
This category includes the following rules that match people based on their descendant relations to other people:

Is een afstammeling van This rule matches people who are descendants of the specified person. The
Inclusive option determines whether the specified person should be consi-
dered his/her own descendant (useful for building reports).

You can either enter the ID into a text entry field, or select a person from
the list by clicking Select... button. In the latter case, the ID will appear in
the text field after the selection was made.

Is a descendant of person at least N
generations away

This rule matches people who are descendants of the specified person
and are at least N generations away from that person in their lineage. For
example, using this rule with the value of 2 for the number of generations
will match grandchildren, great-grandchildren, etc., but not the children of
the specified person.

Is een afstammeling van de persoon
niet méér dan N generaties verwij-
derd

This rule matches people who are descendants of the specified person and
are no more than N generations away from that person in their lineage. For
example, using this rule with the value of 2 for the number of generations
will match children and grandchildren, but not great-grandchildren, etc., of
the specified person.

Is a descendant of filter match This rule matches people who are descendants of someone who is matched
by the specified filter. The specified filter name should be selected from
the menu.

Is a descendant family member of This rule not only matches people who are descendants of the specified
person, but also those descendants' spouses.

C.6. Relatie-filters
This category includes the following rules that match people based on their mutual relationship:

Relationship path between two peo-
ple

This rule matches all ancestors of both people back to their common an-
cestors (if exist). This produces the "relationship path" between these two
people, through their common ancestors.

You can either enter the ID of each person into the appropriate text entry
fields, or select people from the list by clicking their Select... buttons. In the
latter case, the ID will appear in the text field after the selection was made.

C.7. Verscheidene filters
This category includes the following rules which do not naturally fit into any of the above categories:

Heeft het persoonlijk kenmerk This rule matches people who have the personal attribute of the specified
value. The specified personal attribute name should be selected from the
menu. The specified value should be typed into the text entry field.

Heeft het familiekenmerk This rule matches people who have the family attribute of the specified
value. The specified family attribute should be selected from the menu. The
specified value should be typed into the text entry field.

Matches the filter named This rule matches people who are matched by the specified filter. The spe-
cified filter name should be selected from the menu.
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Bijlage D. Commandoregel referentie
This appendix provides the reference to the command line capabilities available when launching GRAMPS from
the terminal.

Opmerking

GRAMPS werd ontworpen om een interactief programma te zijn. Daarom gebruikt het een grafische
voorstelling en kan dus niet vanuit een echte niet-grafische console gelopen worden. Het zou een
enorm veel moeite kosten om het programma te kunnen draaien in een enkel-tekst omgeving. Dit
is de reden waarom de commandolijn opties niet trachtten om volledig komaf te maken met de
afhankelijkheid van een grafisch beeld. Het maakt echter het uitvoeren van enkele (kenmerkende)
taken gemakkelijker!

Tip

To summarize, the use of the command line options provides non-interactive behavior, but does not
get rid of graphical display dependency. Take it or leave it!

D.1. Beschikbare opties
This section provides the reference list of all command line options available in GRAMPS. If you want to know
more than just a list of options, see next sections: Paragraaf D.2, “Actie” and Paragraaf D.3, “Voorbeelden”.

D.1.1. Formaatopties
The format of any file destined for opening, importing, or exporting can be specified with the -f format option.
The acceptable format values are listed below.

grdb GRAMPS gegevensbestand. Dit formaat is beschikbaar om te openen, te importeren en te ex-
porteren. Wanneer niet specifiek opgegeven, wordt het bestandsformaat afgeleid van de extensie
.grdb

gramps-xml GRAMPS XML gegevensbestand. Dit formaat kan geopend, geïmporteerd en geëporteerd wor-
den. Wanneer niet opgegeven kan formaat afgeleid worden uit de extensie .gramps

gedcom GEDCOM-bestand. Dit formaat kan geopend, geïmporteerd en geëporteerd worden. Wanneer
niet opgegeven kan formaat afgeleid worden uit de extensie .ged

gramps-pkg GRAMPS-pakket. Dit format is beschikbaar voor import en export. Wanneer niet opgegeven
kan formaat afgeleid worden uit de extensie .gpkg

geneweb GeneWen bestanden. Dit format is beschikbaar voor import en export. Wanneer niet opgegeven
kan formaat afgeleid worden uit de extensie .gw

wft Web Family Tree. Dit format is beschikbaar voor import en export. Wanneer niet opgegeven
kan formaat afgeleid worden uit de extensie .wft

iso CD image. This format is available for export only. It must always be specified explicitly.

D.1.2. Openingsopties
Er zijn twee manieren om GRAMPS te laten weten welk bestand dient geopend te worden:

• geef de bestandsnaam op zonder extensie
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• of gebruik de opdrachtregel: -O bestandsnaam of -open=bestandsnaam

If the filename is given without any option flag, the attempt to open the file will be made, and then the interactive
GRAMPS session will be launched.

Tip

If no option is given, just the file name, GRAMPS will ignore the rest of the command line arguments.
Use the -O flag to open the file and do something with the data.

The format can be specified with the -f format or --format=format option, immediately following the fi-
lename. If not specified, the guess will be attempted based on the filename.

Tip

Enkel de volgende formaten kunnen rechtsreeks geopend worden: grdb, gramps-xml en gedcom.
Voor andere formaten moet u gebruik maken van de importeer-optie. Maak een leeg gegevensbestand
aan en importeer de gegevens hierin.

Tip

Slecht één bestand kan geopend worden. Indien u gegevens van meerdere bestanden wenst te com-
bineren, moet u de importeeropties gebruiken.

D.1.3. Importeeropties

The files destined for import can be specified with the -i filename or --import=filename option. The format
can be specified with the -f format or --format=format option, immediately following the filename. If not
specified, the guess will be attempted based on the filename.

Tip

Met één opdrachtregel kunnen meerdere bestanden geimporteerd worden. In dit geval zal GRAMPS
de gegevens van het volgende bestand meenemen in het gevensbestand dat momenteel beschikbaar
is.

When more than one input file is given, each has to be preceded by -i flag. The files are imported in the specified
order, i.e.  -i file1 -i file2  and  -i file2 -i file1  might produce different GRAMPS IDs in the resulting
database.

D.1.4. Exporteeropties

The files destined for export can be specified with the -o filename or --output=filename option. The format
can be specified with the -f option immediately following the filename. If not specified, the guess will be
attempted based on the filename. For iso format, the filename is actually the name of directory the GRAMPS
database will be written into. For grdb, gramps-xml, gedcom, wft, geneweb, and gramps-pkg, the filename is
the name of the resulting file.

Tip

Met één opdrachtregel kunnen meerdere bestanden geëxporteerd worden. In dit geval zal GRAMPS
verschillende bestanden trachten weg te schrijven gebaseerd op de gegevens die op dat moment
beschikbaar zijn in het gegevensbestand.

When more than one output file is given, each has to be preceded by -o flag. The files are written one by one,
in the specified order.
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D.1.5. Actie-opties
The action to perform on the imported data can be specified with the -a action or --action=action option.
This is done after all imports are successfully completed.

Momenteel aanwezige opties zijn:

samenvatting This action is the same as Reports->View->Summary

controle This action is the same as Tools->Database Processing->Check and Repair.

verslag This action allows producing reports from the command line. As reports generally have many
options of their own, this action should be followed by the report option string. The string is
given using the -p option_string or --options=option_string option.

Tip

De deeltekenreeks van de verslagoptie moet voldoen aan volgende voorwaar-
den:

• Mag geen spaties bevatten. Indien sommige argumenten toch spaties bevat-
ten moet de deeltekenreeks tussen aanhalingstekens geplaatst worden.

• Option string must list pairs of option names and values.

• Within a pair, option name and value must be separated by the equal sign.

• Indien er verscheidene paren zijn moeten deze dmv. comma's gescheiden
worden.

Most of the report options are specific for every report. However, there some common options.

naam=verslag_naam This mandatory option determines which report will be genera-
ted. If the supplied report_name does not correspond to any avai-
lable report, the error message will be printed followed by the list
of available reports.

toon=alles This will produce the list of names for all options available for
a given report.

toon=optie_naam This will print the description of the functionality supplied by the
option_name, as well as what are the acceptable types and values
for this option.

Gebruik de bovenstaande opties om meer te weten te komen over een bepaald report.

Tip

If an option is not supplied, the last used value will be used. If this report has
never been generated before, then the value from last generated report will be
used when applicable. Otherwise, the default value will be used.

Wanneer méér dan één uitvoeroptie gegeven is zal elke actie voorafgegaan moeten worden door de -a vlag. Deze
acties zullen één per één uitgevoerd worden in de opgegeven volgorde.

D.2. Actie
• If the first argument on the command line does not start with dash (i.e. no flag), GRAMPS will attempt to

open the file with the name given by the first argument and start interactive session, ignoring the rest of the
command line arguments.
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• If the -O flag is given, then GRAMPS will try opening the supplied file name and then work with that data,
as instructed by the further command line parameters.

Opmerking

Only one file can be opened in a single invocation of GRAMPS. If you need to get data from
multiple sources, use the importing options by using -i flag.

• With or without the -O flag, there could be multiple imports, exports, and actions specified further on the
command line by using -i, -o, and -a flags.

• The order of -i, -o, or -a options with respect to each does not matter. The actual execution order always is:
all imports (if any) -> all exports (if any) -> all actions (if any).

Opmerking

Maar het openen moet steeds als eerste actie gebeuren!

• If no -O or -i option is given, GRAMPS will launch its main window and start the usual interactive session
with the empty database, since there is no data to process, anyway.

• If no -o or -a options are given, GRAMPS will launch its main window and start the usual interacti-
ve session with the database resulted from opening and all imports (if any). This database resides in the
import_db.grdb file under the ~/.gramps/import/ directory.

• Alle fouten gevonden gedurende een importeer of exporteer of enige andere actie, zullen ofwel gestuurd wor-
den naar de standaard uitvoer (indien deze uitzonderingen behandeld worden door GRAMPS) of in het andere
geval naar een foutbestand (indien die niet behandeld worden).

D.3. Voorbeelden
Om vier gegevensbestanden (waar-
van het formaat kan bepaald wor-
den aan de namen) te importeren en
vervolgens het resultaatgegevens-
bestand te controleren op fouten:

gramps -i file1.ged -i file2.gpkg -i ~/db3.gramps -i
file4.wft -a controle

Om de formaten in bovenstaande
voorbeelden expliciet aan te geven,
voegt u de de -f opties:

gramps -i file1.ged -f gedcom -i file2.gpkg -f gramps-pkg -i
~/db3.gramps -f gramps-xml -i file4.wft -f wft -a controle

To record the database resulting
from all imports, supply -o flag
(use -f if the filename does not al-
low GRAMPS to guess the format):

gramps -i file1.ged -i file2.gpkg -o ~/new-package -f
gramps-pkg

To save any error messages of the
above example into files outfile
and errfile, run:

gramps -i file1.ged -i file2.dpkg -o ~/new-package -f
gramps-pkg >outfile 2>foutbestand

Om drie gegevensbestanden te im-
porteren, een interactieve sessie
GRAMPS-sessie te starten met als
resultaat:

gramps -i file1.ged -i file2.gpkg -i ~/db3.gramps

Om een gegevensbestand te ope-
nen, en gebaseerd op deze ge-
gevens een tijdslijnverslag aan
te maken in PDF-formaat en

gramps -O bestand.grdb -a verslag -p
name=timeline,off=pdf,of=my_timeline.pdf
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de uitvoer te sturen naar het
mijn_tijdslijn.pdf bestand,
voert u in:

Tip

Om alle beschikbare opties te vinden van het tijds-
lijnverslag, gebruikt u naam=tijdslijn,toon=alle.
Om meer te weten over een detail van een be-
paalde optie, gebruikt u toon=optie_naam, bv.
naam=tijdslijn,toon=off.

Om meer te weten te komen over de verslagnamen gebruikt
u de deeltekenrreeks naam=toon

En tenslotte, om een interactieve
sessie te starten geeft u in:

gramps
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Bijlage E. Over GRAMPS
GRAMPS werd geschreven door Donald N. Allingham (<don@gramps-project.org>).
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• Eero Tamminen

• Samuel Tardieu

• Richard Taylor

• James Treacy

• Lubo Vasko

• Sebastian Voecking

• Xing Wang
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If you know of somebody else who should be listed here, please let us know.

Wilt u meer weten over GRAMPS, ga dan naar deze link: GRAMPS Project Web page [http://gramps-project.org].

To report a bug or make a suggestion regarding this application or this manual, use the help menu in GRAMPS,
or follow the directions on this site. [http://gramps.sourceforce.net/contact.html]

Dit programma wordt verdeeld onder de voorwaarden van de GNU publieke licentie zoals gepubliceerd door de
"Free Software Foundation"; ofwel de versie 2 van dze licensie, ofwel elke latere versie (dit is uw keuze). Een
kopie van de licensie kunt u vinden onder deze link: link [ghelp:gpl], of in het bestand "COPYING" dat bijgevoegd
werd bij de broncode van dit programma.

http://gramps-project.org
http://gramps.sourceforce.net/contact.html
ghelp:gpl
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